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Preface
This guide is intended for business users who are responsible for onboarding customers and maintaining 
customer data.

Informatica Resources
Informatica provides you with a range of product resources through the Informatica Network and other online 
portals. Use the resources to get the most from your Informatica products and solutions and to learn from 
other Informatica users and subject matter experts.

Informatica Network
The Informatica Network is the gateway to many resources, including the Informatica Knowledge Base and 
Informatica Global Customer Support. To enter the Informatica Network, visit 
https://network.informatica.com.

As an Informatica Network member, you have the following options:

• Search the Knowledge Base for product resources.

• View product availability information.

• Create and review your support cases.

• Find your local Informatica User Group Network and collaborate with your peers.

Informatica Knowledge Base
Use the Informatica Knowledge Base to find product resources such as how-to articles, best practices, video 
tutorials, and answers to frequently asked questions.

To search the Knowledge Base, visit https://search.informatica.com. If you have questions, comments, or 
ideas about the Knowledge Base, contact the Informatica Knowledge Base team at 
KB_Feedback@informatica.com.

Informatica Documentation
Use the Informatica Documentation Portal to explore an extensive library of documentation for current and 
recent product releases. To explore the Documentation Portal, visit https://docs.informatica.com.

Informatica maintains documentation for many products on the Informatica Knowledge Base in addition to 
the Documentation Portal. If you cannot find documentation for your product or product version on the 
Documentation Portal, search the Knowledge Base at https://search.informatica.com.
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If you have questions, comments, or ideas about the product documentation, contact the Informatica 
Documentation team at infa_documentation@informatica.com.

Informatica Product Availability Matrices
Product Availability Matrices (PAMs) indicate the versions of the operating systems, databases, and types of 
data sources and targets that a product release supports. You can browse the Informatica PAMs at 
https://network.informatica.com/community/informatica-network/product-availability-matrices.

Informatica Velocity
Informatica Velocity is a collection of tips and best practices developed by Informatica Professional Services 
and based on real-world experiences from hundreds of data management projects. Informatica Velocity 
represents the collective knowledge of Informatica consultants who work with organizations around the 
world to plan, develop, deploy, and maintain successful data management solutions.

You can find Informatica Velocity resources at http://velocity.informatica.com. If you have questions, 
comments, or ideas about Informatica Velocity, contact Informatica Professional Services at 
ips@informatica.com.

Informatica Marketplace
The Informatica Marketplace is a forum where you can find solutions that extend and enhance your 
Informatica implementations. Leverage any of the hundreds of solutions from Informatica developers and 
partners on the Marketplace to improve your productivity and speed up time to implementation on your 
projects. You can find the Informatica Marketplace at https://marketplace.informatica.com.

Informatica Global Customer Support
You can contact a Global Support Center by telephone or through the Informatica Network.

To find your local Informatica Global Customer Support telephone number, visit the Informatica website at 
the following link: 
https://www.informatica.com/services-and-training/customer-success-services/contact-us.html.

To find online support resources on the Informatica Network, visit https://network.informatica.com and 
select the eSupport option.
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C h a p t e r  1

Introduction to Informatica MDM - 
Customer 360

This chapter includes the following topics:

• Overview of Informatica MDM - Customer 360, 10

• Key Concepts, 11

• Logging In, 12

• User Interface, 13

Overview of Informatica MDM - Customer 360
Informatica MDM - Customer 360 provides clean, consistent, and connected information about customers. 
Business managers use the master customer data to make better business decisions about customers and 
manage customer relationships. You can get a single trusted view of a customer.

With Customer 360, business users can achieve the following goals:

• Streamline the customer onboarding and qualification process.

• Centralize the data about customers in a master database.

• View the relationships between customers, parent companies, subsidiaries, and related organizations.

• Design campaigns based on customer preferences and behavior.

• Improve customer service.

• Connect customer data to the product catalogs and view the buying patterns.

• View customer-to-product relationships.

Customer 360 is based on Multidomain MDM. Business users connect to master customer data through a 
business-friendly user interface. The user interface displays an enterprise-level dashboard as well as 360 
degree customer views that are customized for different business users.

The Customer 360 environment integrates with Informatica Product 360, which is a product information 
management system.

Use Customer 360 to access the master data that is stored in the Hub Store. Master data is organized by 
business entities. Business entities are the type of top-level data that has significance for an organization. 
Business entities include persons and organizations.

10



Business users use Customer 360 to perform the following activities:

• Add records.

• Search for and edit records.

• Manage relationships between records.

• Participate in review processes for new and changed records.

• Import records in bulk to create new customers.

Key Concepts
To work effectively in Customer 360, you need a basic understanding of Informatica Master Data 
Management concepts.

Business Entities
Business entities are an implementation of master data domains in your application. For example, the 
Customer master data domain can be implemented in the following types of business entities: Person, 
Patient, or Policy Holder.

The business entity data structure maps to the base object tables in the Operational Reference Store 
database. The base object tables contain all the master records. For example, the root node of a business 
entity corresponds to the root base object table. A child node in the business entity corresponds to a child 
base object table. Business entities can have an unlimited depth, though the views that display the child 
records might not be able to show all levels in a meaningful way beyond a certain depth. 

Related Topics:
• “Adding Records Overview” on page 23

• “Adding a Person Scenario” on page 24

• “Finding Records Overview” on page 30

Search and Compare
A best practice in data governance is to check for existing records before adding new records. When you 
begin adding a record, Customer 360 searches for duplicate records.

You can preview the potential duplicate records as they appear and take one of the following actions:

• If more than one record is a potential match for the record you are adding, you can compare the records 
side by side. If you find that the records are duplicates, you can initiate a merge.

• If one record matches the record you are adding, you can open the record and begin working with it. In this 
case, the record that you started adding is discarded.

• If none of the records is a match, you can continue adding the new record.

The MDM administrator configures the fields to use in the search for potential duplicates. 
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Merge
After you compare records, you can merge records that appear to be duplicated.

When you merge a record, the root records of the merged record are consolidated into a single root record. 
The child records from each of the root records become child records of the merged root record. 

Review Processes and Tasks
A review process is an automated business process. When a user adds, edits, merges, or unmerges records, 
the action can initiate a review process. A review process ensures that business managers or data stewards 
review and ultimately approve the data before it becomes master data. 

Your user role determines whether a change to the master data triggers a review. For example, if your user 
role permits you to add or edit data but not approve changes, then when you save an edit or merge records, 
the action triggers a review process.

A review process contains people activities. A people activity is a point in the review process when the 
process requires human participation. When an instance of a review process reaches a people activity, the 
review process sends a task notification. Business managers and data stewards receive task notifications in 
their task inboxes. 

Hierarchies and Relationships
A business entity can have relationships to other business entities. You can view a graph that shows how a 
business entity is related to other business entities. Use the Hierarchy view to examine the relationships 
between the open business entity and other business entities.

You can see the business entity relationships in the entity view. The relationship panels on the right display 
the relationship for the business entity. Use the panels to add relationships.

DaaS Validation
Validation and verification of postal addresses, email addresses, and phone numbers improves the ability to 
contact your customers. Use the integration of Customer 360 with Informatica DaaS for data verification and 
correction. You can verify customer contact information and store accurate data in the database.

You can analyze, verify, correct, and format addresses according to the local postal standards. Ensure that 
the email addresses are valid and formatted correctly. Find email domains involved with spam networks, 
traps, and other malicious threats and verify that the email address is valid, not valid, or malicious. Verify the 
phone numbers of your customers and ensure your ability to connect.

Logging In
To log in, you need the URL for Customer 360 and your user credentials.

1. Open a supported browser, such as Chrome. 

2. Enter the URL for Customer 360. The URL has the following format: 

http://<MDM Server host name>:<MDM Server port number>/c360/
com.informatica.tools.mdm.web.auth/login
The Log In page opens. 
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3. Enter your user name and password. 

4. Click Log In. 

5. If prompted, select the Customer 360 application. 

The application opens and displays the Home page. Your username appears in the application header. 

User Interface
The Customer 360 user interface contains a navigation pane on the left and a details pane on the right. Click 
a link in the Left pane to open the corresponding pages, such as New menu, File Import, and Task Manager. 
The details pane displays details about the link you select in the left navigation pane.

The following image shows the user interface with the Home page displayed: 

Customer 360 has the following tabs:

Home

The Home page is your dashboard and monitoring page. The page contains the tasks panel, records 
panel, and a collection of charts. The charts give a visual summary of the customers and task details. 
Managers and administrators can view a list of review tasks in the tasks panel. The records panel lists 
the records that you have submitted or saved as drafts.
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New

The New page lists the type of master data that you can add. Your user role must permit you to add the 
master data. Use the New tab to add records.

Search

The Search page contains the search results. Use the Search page to find records. You can open a 
record from the search results.

Task Manager

The Task Manager page displays the tasks that are assigned to you and all unclaimed tasks. Use the 
Task Manager to organize, claim, and resolve tasks that the review processes generate.

My Records

The My Records page contains the list of drafts, submitted records, and the details pane. When you 
create a record, you can save the data as a draft. Use the My Records page to find, edit, and delete 
drafts. When a draft is complete, you can submit the draft for approval.

File Import

The File Import page contains the options to import data into Customer 360. Follow the steps to select 
and import data.

Charts and Graphs
Charts and graphs on the Home page contain enterprise-level information about all customers and tasks. You 
can view a visual representation of the customers and related information. You can view the breakdown of 
tasks, grouped by their state and priority.

The charts and graphs can be static or dynamic. Before you analyze the data, ensure that the data reflects 
the current master data. Your administrator can add or remove charts from the Home page. All managers 
share the same Home page, so you might want to coordinate with other managers before requesting 
changes.

Chart Description

Customers Added By Year Displays the number of customers added in each year.

Customer By Onboarding Time Displays how long it took to qualify customers.

Source Systems Displays the percentage of customer data that comes from each source 
system in each year.

Tasks Overview Displays the total number of tasks and breaks down the tasks by status 
and priority.

Assigned Tasks By Users Displays the total number of tasks assigned to each user.

Closed Tasks By Users Displays the total number of tasks closed by each user.

Open Tasks By Task Type Displays the total number of tasks that are open for each task type.

Assigned Tasks By User Roles Displays the total number of tasks assigned to each user role.

14       Chapter 1: Introduction to Informatica MDM - Customer 360



Task Inbox
A task is a request to participate in a review process. For example, you might need to approve a new record 
or review changes to a record. You receive task notifications in the task inbox. By default, the task inbox 
displays the tasks based on the first quick filter. For example, if the first quick filter is My Open Tasks, the 
task inbox lists all your open tasks. 

The following image shows the task inbox with the My Closed Tasks filter selected: 

1. Quick filters
2. Column filter
3. Refresh icon
4. Table Settings icon

The following table describes the elements in the task inbox:

Inbox 
Element

Description

Filters Filters the tasks based on the filter criteria. You can use the following types of filters alone or in 
combination: 
- Quick filters. Filters the tasks based on the predefined filter that you select.
- Column filters. Filters the tasks based on the task properties that are visible in the list. 

View All Displays the details of all the listed tasks in the Task Manager.

Refresh icon Updates the contents of the task inbox. 

Table Settings 
icon

Opens a dialog box where you can configure the columns for each quick filter listed in the task inbox.

Task Title A link that displays a short description of the review task. To review the record and take action on 
the task, click the task title. The task opens in the Task Manager and displays the associated record 
in the review panel. If your role permits it, you can edit the record from this view before taking action 
on the task. 

ID Instance ID of the review process that generated the task. 

Type Name of a people activity within the process. 

Priority Priority of the task. The task priority can be Low, Normal, or High. When generating tasks, the review 
process assigns the same priority to all tasks of the same type. 

User Interface       15



Inbox 
Element

Description

Due Date Date the task is due. The review process calculates a default due date based on the task creation 
date plus a predefined time period. 
The due date of each task is prefixed with one of the following colored dots:
- Green. Indicates that the task is not overdue.
- Red. Indicates that the task is overdue.
- Amber. Indicates that the task will be overdue in the next 24 hours.

Status Status of the task can be Open or Closed. When the task status is Open, you can view the record 
associated with the task.

Owner Name of the signed-in user. 

Creator Name of the user who created the task.

Creation Date Date on which the user created the task.

My Records Page
Use the My Records page to organize your work and get an insight into your drafts and records submitted for 
approval. You can work on the drafts and submit them for approval.

To go My Records, click My Records in the left navigation pane.

The following image shows the My Records page: 
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C h a p t e r  2

Getting Started
This chapter includes the following topics:

• Getting Started Overview, 17

• Home Page, 17

• Sorting and Filtering Tasks, 18

• Configuring the Columns for the Task Inbox, 19

• Viewing Customer Data, 19

Getting Started Overview
After you log in to Informatica MDM - Customer 360, you see the Home page. The Home page is unique to 
your user role.

Based on the Home page layout, you might be able to monitor data in reports, run a search in an embedded 
search engine, and organize your tasks.

Home Page
The Home page is your dashboard and monitoring page that displays a list of tasks and a collection of charts 
and graphs.

The Home page contains the following components:

Task Inbox

After a business user creates or edits record data, the action initiates a business process. The business 
process generates tasks to managers to participate in the review process. The task inbox displays tasks 
that you claim and all unclaimed tasks.

Drafts and Submissions

After you create or edit record data, you can save the form as draft to submit later. Users can view only 
their drafts and submitted forms.

Charts and Graphs

Charts and graphs include tasks overview, customer onboarding time, customers added by year, and 
source systems.
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Sorting and Filtering Tasks
You can sort and filter the list of tasks in the task inbox. For example, you might want to review edited 
records before you review merge proposals.

The task inbox contains quick filters and column filters. You can use these filters in combination to get 
specific results. For example, to see high priority tasks assigned to you, select the My Open Tasks quick filter 
and set the Priority column filter to High. In logical terms, filters are joined by the AND operator.

Note: You can set one column filter at a time. For example, you can narrow your list to Organizations and then 
further restrict the results to show only the Merge tasks for organizations.

1. In the navigation bar, click Home. 

The task inbox appears. 

2. To sort the list of tasks by a field, click the column heading with that field name. 
For example, to sort tasks by task type, click the Task Type column heading. 

Sorts the tasks based on the values in the selected column. An up arrow beside the column heading 
indicates that the values are sorted in ascending order. A down arrow indicates descending order. 

Note: By default, the task inbox sorts tasks case insensitively. If the number of tasks to sort is more than 
the value of the CompositePagerTotalRecords property, case-sensitive sorting is database dependent. 
For more information about the CompositePagerTotalRecords property, see the Multidomain MDM Data 
Director Implementation Guide.

3. To filter the list of tasks, set filter criteria in any order. 

• To filter tasks by the most commonly used criteria, select one of the following quick filters: 

Filter Description

My Open Tasks Shows your open tasks.

My Closed Tasks Shows the tasks that you closed.

All Tasks Shows all the closed, claimed, and unclaimed tasks that are assigned to your user 
group.

All Unclaimed Tasks Shows all the unclaimed tasks that are assigned to your user group. 

All Closed Tasks Shows all the tasks that the users in your user group closed.

All Claimed Tasks Shows all the tasks that the users in your user group claimed.

• To filter tasks based on the values of column headings, enter appropriate values for the following 
column headings:

Option Description

Task Title Shows tasks that contain the specified text. Enter the text that you want to search for in the 
task titles. 

Type Shows tasks with the selected task type. Select a task type from the list, such as Final 
Review or Merge.
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Option Description

Priority Shows tasks with the selected priority, such as High. Select a priority from the list.

Due Date Shows tasks that are overdue or due in a specific period. Select a due date option from the 
list.

Status Shows tasks with the selected status, such as Open or Closed. Select a status from the list.

Owner Shows tasks that are assigned to the user. Enter a user name. 

Creator Shows tasks that the specified user created.

Creation Date Shows tasks that are created during a specific period of time. Select a creation date option 
from the list, such as Last 7 days or Custom range.

4. To remove filters, click the Clear Filter icon. 

Configuring the Columns for the Task Inbox
By default, the task inbox displays the columns that the administrator configured for all the quick filters. For 
each quick filter, you can add or remove the available columns.

1. In the navigation bar, click Home. 

The task inbox appears. 

2. Select a quick filter for which you want to configure the columns. 

3. Click Table Settings. 

The Table Settings dialog box appears.

4. To add a column heading, in the Available Fields section, select a field and click Add. 

5. To remove a column heading, in the Selected Fields section, select a field, and click Remove. 

6. Click OK. 

Viewing Customer Data
You can view the summary of customer details from a customer dashboard. Search for a customer that you 
want to view. If multiple business customers appear in the search results, you can use filters to refine the 
search. After you find the customer, click the customer record to view the details.

Customer Dashboard
A customer dashboard displays all relevant information of the customer. The dashboard displays customer 
details, such as contact information, financial data, preferences, previous purchases, hierarchies, tweets, and 
attached documents.

Note: You cannot edit the data in a dashboard view.
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The following image shows the customer dashboard for a person type customer: 

The Product Details panel displays the product purchase history of the customer. Each product in the panel is 
a link that you open and view the product details.
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The following image shows the details of a product: 
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The following image shows the customer dashboard for an organization type customer: 

The Hierarchies panel displays how a record is related to other records in a hierarchical format. A record can 
belong to multiple hierarchies. If an MDM Hub administrator defines a default hierarchy, the Hierarchies 
panel displays the default hierarchy for the record. Otherwise, the Hierarchies panel displays a list of 
hierarchies to which the record belongs. You can then select a hierarchy that you want to view. After you 
select a hierarchy, you can click a record to view the record details.

The Documents panel displays the list of documents that belong to a customer. You can filter, sort, and 
download the documents.
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C h a p t e r  3

Adding Records
This chapter includes the following topics:

• Adding Records Overview, 23

• Adding a Person Scenario, 24

• Adding an Organization Scenario, 24

• Adding a Person Record, 25

• Adding an Organization Record, 26

• DaaS Validation Overview, 26

• Validating a Postal Address, an Email Address, or a Phone Number, 27

• Adding a Household, 28

• Adding an Address, 28

• Adding a Time Period, 28

• Adding a Time Period Group, 29

• Adding a Classification Value, 29

• Adding a Campaign, 29

Adding Records Overview
You can add records to the master data. The application developer defines the business entities, including 
the data and structure. The developer also designs the layout of the Business Entity views that open when 
you create a record.

Data entry form panel

The main panel in the view is the data entry form. Required fields have a red line.

Similar Records panel

If the view contains the Similar Records panel, as you enter data in required fields, Informatica MDM - 
Customer 360 generates a list of similar records for your review. Review the similar records before 
finishing the form. If you find the record already exists, you can edit the existing record instead of adding 
a new record. If you are uncertain whether a similar record is the same record that you want to add, 
continue adding the new record. If you add a duplicate record, Customer 360 can find and consolidate 
matching records for you.
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Data Validation
When a user adds or changes data, Customer 360 checks the data against metadata and, optionally, 
validation rules. The metadata defines the expected format for the data, such as the data type or the number 
of characters permitted. Customer 360 has additional validation rules such as validation of government 
identifiers, addresses, phones numbers, and emails addresses.

Validation processes run at the field level, section level, and record level:

• Field level. When you add or edit data in a field in the Business Entity view, a client-side validation process 
verifies that the data satisfies the metadata. For example, when you enter a date in a Date field and then 
navigate away from the field, the process verifies that you entered the date in the expected date format.

• Section level. When you apply all changes in a section in the Business Entity view, a client-side validation 
process verifies that all data satisfies the metadata and that the required fields contain data.

• Record level. When you save a record in the Business Entity view, a server-side validation process verifies 
that data satisfies the metadata and the validation rules.

If user input does not satisfy the metadata or the validation rules, you see messages about the problems with 
the data.

Adding a Person Scenario
You are an insurance agent for a large insurance company. You have a new customer, Anthony Lomax, on the 
phone. You want to add Mr. Lomax as a record.

To add Anthony Lomax, you perform the following steps:

1. Click New, and then you select Person as the business entity.

2. In the Last Name field, you type Lomax. In the First Name field, you type Anthony.

3. In the Similar Records panel, you see a potential duplicate, so you open the similar record.

4. You confirm with Mr. Lomax that he is not the same person as the existing Anthony Lomax, and then 
close the similar record.

5. You finish adding Mr. Lomax's information in the form.

Adding an Organization Scenario
You are with the marketing department of a company. You have a new customer, CITIGROUP which is an 
organization. You want to add CITIGROUP as an Organization record.

To add CITIGROUP, you perform the following steps:

1. Click New, and then select Organization as the business entity.

2. In the Legal Business Field, type CITIGROUP.

3. Fill in all the other required fields.

4. If you see a potential duplicate record in the Similar Records panel, open the similar record.

5. Review and confirm that the similar record is not a duplicate record, and then close the similar record.

6. Finish adding data in the data entry form, and then click Save.
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Adding a Person Record
To add a Person type record, start from the New menu.

1. Click New, and then click Person. 

The data entry form for New Person opens. A red line on a field indicates a required field.

2. For each required field in the form, click the field, and type a value. 

3. If the Similar Records panel contains a list of similar records, review them. 

a. In the Similar Records panel, click the information icon beside the name of a record. 

b. Check the other data values to see if the record is the same as the one you are adding. 

• If it is the same record, click View. The selected record opens in an entity tab. You can edit data 
as required. You can view the child records for the record. You can discard the work-in-progress 
record.

• If it is not the same record, click Close.

c. Review other similar records in the same way. 

d. If a record does not exist, return to the tab containing the work-in-progress customer record. 

4. In the customer creation form, add data in the optional fields. 

a. Fill in the fields. 

b. Optionally, add an image. Type a valid URL in the image field. 

Note: For best results, use an image that is a maximum of 200 x 200 pixels. For images, the MDM 
Hub stores the URL, not the file. If the location of the file changes, you must update the URL.

c. Click Apply. 

5. To add a child record to the record, perform the following steps: 

a. In the navigation menu, click a section name. For example, Documents. 

b. Click Create Child Record. 

The data entry form for the child record appears.
The following image shows the data entry form of the Documents section: 

1. Table view
2. Form view
3. Create Child Record
4. Discard
5. Apply

c. To switch from the form view to the table view of the fields, click Table. 

d. Fill in the fields. 

For a file attachment field, browse and select the file you want to attach, and then click Open.

Note: By default, you can attach .pdf and .jpg files.

e. Click Apply. 
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6. After you finish adding data, click Save. 

By default, the Draft check box is selected. When you click Save, the in-progress customer record is 
saved as a draft. Later you can submit the record for approval. If you do not want to save the record as 
draft, clear the check box before you save the record.

Note: If you are a user with an approver role, ensure that you clear the draft check box.

If your user role permits you to save data without a review, Customer 360 saves the record as an active 
record. Otherwise, Customer 360 saves the record as a pending record and initiates the review process 
associated with your role.

Adding an Organization Record
To add an organization record, select the business entity as Organization.

1. Click New, and then select Organization. 

The data entry form for New Organization opens. A red line on a field indicates a required field.

2. Fill in the required fields and other fields as required. 

3. If you want to add a related person record, perform the following tasks: 

a. In the Contacts section, click the Create Child Record icon. 

b. Type the first name and last name of the person. 

c. In the Relationship Type box, type one of the following values: 

• ContactContact. Specifies the person as a contact for the organization.

• ContactEmployee. Specifies the person as an employee of the organization.

d. Enter values in other fields as required. 

e. Click the Apply icon. 

4. Click Save. 

By default, the record is saved as a draft, and you can later submit the record for approval. If you do not 
want to save the record as a draft, clear the Draft check box before you save the record.

Note: If you are a user with an approver role, ensure that you clear the draft check box.

If your user role permits you to save data without a review, Customer 360 saves the record as an active 
record. Otherwise, Customer 360 saves the record as a pending record and initiates the review process 
associated with your role.

DaaS Validation Overview
Validation and verification of addresses, email addresses, and phone numbers improves the ability to contact 
your customers. Use the integration of Customer 360 with Informatica DaaS for data verification and 
correction. You can verify customer contact information and store accurate data in the organization.

You can analyze, verify, correct, and format addresses according to the local postal standards. Ensure that 
the email addresses are valid and formatted correctly. Find email domains involved with spam networks, 
traps, and other malicious threats and verify that the email address is valid, not valid, or malicious. Verify the 
phone numbers of your customers and ensure your ability to connect.
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Address Verification and Standardization
You can improve the quality of your address data. You can correct, standardize, and verify international 
postal addresses in the address fields of your customer records. You can format the postal address 
according to the requirements of the local postal authorities.

Verify the postal addresses when you create customer records. You can also verify existing addresses and 
any changes you make to the address data.

You can verify an address when you select the verification check box and save the record.

Email Address Validation
Verify the email address in the email address fields of the customer records. You can verify whether an email 
address exists and is formatted correctly. You can identify known or potentially dangerous email addresses 
or domains.

Validate and verify the email addresses in real time at the point of entry when you create a customer record. 
You can verify existing email addresses and any changes you make to the email address data.

You can verify an email address when you select the verification check box and save the record.

Phone Validation
You can validate customer phone numbers in the phone fields of your customer records.

Validate phone numbers in real time when you create a customer record. You can validate existing phone 
numbers and any changes you make to the phone data.

You can validate a phone number when you select the verification check box and save the record.

Note: Phone number validation is accurate when you specify country code.

Validating a Postal Address, an Email Address, or a 
Phone Number

You can validate the postal address, email address, and phone number of your customer records. You can 
perform the validation when you create a customer record or when you update a customer record. You can 
validate the data in the parent and the child fields.

1. Open the record creation form to add a new customer or search and select a customer record to edit. 

2. Select the check box for the field you want to verify. 

To validate address, select Validate Address. To validate email address, select Validate Email. To 
validate phone number, select Validate Phone.

3. Enter data in the fields for address, email address, and phone number. 

Note: For phone number validation, ensure that you provide the country dialing code.
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4. Click Save. 

For the postal address, email, and phone number fields in the parent record, validation happens when 
you move the cursor out of the data field. For the child records, validation happens when you save the 
record.

If the check box for a field is selected, Customer 360 validates the data in the field and updates the 
validation status in the validation status field.

Adding a Household
A household is a party group. Create a household and add members of the household.

1. Click New, and then select Household. 

The data entry form for new household appears.

2. In the Party Group Name, enter a name for the household. 

3. In the Household Members section, to add a household member, perform the following steps: 

a. Click the Create Child Record icon. 

Fields appear where you can enter data.

b. Fill in the fields. 

c. Click the Apply icon. 

d. Repeat step a to step c for additional members. 

4. After you finish adding data, click Save. 

Adding an Address
Add an address from the New menu.

1. Click New, and then click Address. 

The data entry form for new address appears.

2. In the Address Line 1 field, enter the primary address information. 

All other fields are optional.

3. Click Save. 

Adding a Time Period
Add a time period from the New menu.

1. Click New, and then click Time Period. 

The data entry form for time period appears.
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2. From the Time Period Type list, select the type. 

3. In the Time Period Name field, enter a name for the time period. 

All other fields are optional.

4. Click Save. 

Adding a Time Period Group
Enter a short description of the task here (optional).

1. Click New, and then click Time Period Group. 

The data entry form for the new time period group appears.

2. In the Group Name field, enter a name of the group. 

3. Optionally, enter a description for the group, and then click Save. 

Adding a Classification Value
Add a classification value from the New menu.

1. Click New, and then click Classification. 

The data entry form for new classification appears.

2. From the Classification Type list, select the classification type, such as NAICS or SIC. 

3. In the Classification Value field, enter the value, and then click Save. 

Adding a Campaign
Add a campaign from the New menu.

1. Click New, and then click Campaign. 

The data entry form for new campaign appears.

2. In the Campaign Number field, enter the campaign number. 

3. Optionally, enter a description of the campaign. 

4. From the Campaign Type list, select the campaign type. 

5. From the Campaign Channel Type list, select the campaign channel type. 

6. Specify the reference year. 

7. Click Save. 
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C h a p t e r  4

Finding Records
This chapter includes the following topics:

• Finding Records Overview, 30

• Using the Search Box to Find Records, 32

• Using Queries to Find Records, 35

Finding Records Overview
To find a record, you can either enter a search text in a search box or use a query form. The search results 
show the most important details of the records. You can see more details by opening the records. 

You can use the search box to search and filter records. However, to repeatedly perform the same search and 
filter operation, it is efficient to create and save a query. 

When you use queries, you can search within a specific business entity for which the query is created. 
Whereas, when you use the search box, depending on your environment, in addition to searching within a 
business entity, you might be able to search across all business entities. 

Note: The search options that you see depend on what was configured by the MDM administrator. You must 
have the required privileges for the business entities within which you want to search for records.

Search Page
The Search page is a temporary page that appears when you perform a search from the Search box in the 
application header. A search returns a list of records that satisfy the search criteria.

Use the Search page to review the search results. You can expand a record in a search result to view the 
summary of record details. To refine the search results, you can use filters.

You can group the records that appear in search results based on the business entities. If you group records, 
you can look for records in the relevant business entity groups.
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The following image shows a sample Search page: 

The Search page includes the following sections:

Search Results panel

Displays the total number of results found and lists the records that are part of the search results. You 
can group the records listed in the search results by business entity.

Filter panel

Displays the filter criteria to filter the search results. Use filters to refine the search results based on the 
filter criteria that you select or enter a value for. You can hide the Filter panel if you do not need to filter 
the search results.

Results total

Displays the total number of results found based on the search string that you enter in the Search box.

Filter criteria

Filter properties that you can select or enter a value for to refine search results.

Queries Page
You can click the Queries tab on the navigation bar to access the Queries page. Use the queries page to 
create and run queries. A query returns a list of records that satisfy the criteria that you specify.

When you click the Queries tab, the default query opens. If you do not have a default query, the Saved 
Queries panel appears. To find records, you can create a new query or run a saved query.

After you run a query, the Search Results panel lists the query results. You can customize the query results to 
include only the fields that you want.

The following table describes the user interface elements of the Queries page:

User interface element Description

Query panel Lists the saved queries or the query that is open. The query that you create appears in the 
query panel.

Run Runs the query that is open.

Save Saves a query that you create.
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User interface element Description

Back to Saved Queries Displays the saved queries in the query panel.

Query Results panel Lists the matching records that are the result of a query.

Using the Search Box to Find Records
You can search for records that you want to view, edit, or delete.

1. Optionally, in the Search box in the header, select a type of business entity from the list. 

By default, All is selected, and Customer 360 searches within all the business entity types.

Note: The Search list contains the types of business entities that you have permission to view. If the list 
is empty, contact your MDM administrator to request permission.

2. In the Search box, perform one of the following tasks: 

• Type the complete search string or the search string with the asterisk wildcard character (*) for the 
record that you want to find. You can use the wildcard character at the end of the search string or in 
between the search string. For example, if you want to search for John, you can specify Jo* or J*n.

• If the search is configured to suggest search strings, type a few characters of the search string, and 
select one of the suggested values as the search string.

Note: The values are suggested when you search within a single business entity.

If the search results must contain the words in the search string, add the + operator before each search 
word.

If the search string includes any of the following special characters, add a backslash as a prefix to the 
special character: + , - , & , || , ! , ( ) , { } , [ ] , ^ , " , ~ , ? , : , \ . If you do not add a backslash as a prefix to 
each special character, the search might return no results or incorrect results. For example, if you want 
to search for AT&T, the search string must be AT\&T.

If you want to search for a negative value, type the value in the search string without the minus 
character. For example, if you want to search for -5000, the search string must be 5000.

If you want to search a date, use a simple date format, such as <Month> <DD> <YYYY>, in any order and 
do not use a date format, such as <YYYY>-<MM>-<DD> or YYYY-MM-DDThh:mmTZD. For example, use 
November 20 2014 or 2014 Nov 20 as the search string.

The following image shows the Search box with the search string, John*: 

3. Click the Search icon. 

4. Optionally, group the records that appear in search results based on the business entities. 

The search results are sorted and moved to the relevant business entity groups.
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The following image shows search results in the Person business entity groups, and search results in the 
Secure Person business entity group:

5. To find the record that you are searching for, expand the business entity under which you expect to find 
the record. 

The business entity expands to show all the records that appear in the search result and belong to the 
business entity.
The following image shows the expanded results for the Person business entity:

Filtering Records
After you perform a search, you can refine the search results by using filters. For example, you can refine the 
search results for John Smith by filtering the results by the city name, Toronto.

1. Perform a search. 

The search results appear in the Search page.

2. In the Filter panel, select or enter a value for the filter criteria that you require. 

Note: For a date and time field, you can specify the date in the filter, but not the time. The filter uses the 
default time as 00:00:00 UTC. Some numeric filters might appear in the scientific notation, even though 
the search results display the values in the decimal notation. For example, the filter might display 
10544444.6 as 1.05444446E7.

3. Click Apply Filter. 

The search results contain only the records that match the filters that you applied. A list of the applied 
filters appears below the Search box. You can remove a filter by clicking the X icon for the filter.
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The following image shows that the search results contain only the records that matched the applied 
filters:

1. Applied filters
2. Filtered search results
3. Selected filters

4. To clear all the filter criteria, click Clear All. 

Viewing and Opening a Record
You can view the summary of record details in the Search Results panel of the Search page. To ensure that 
you open the record that you want, review the details for the record before you open it. You can open a record 
in the Business Entity view, the Data view, or the Hierarchy view.

1. From the Search Results panel, select the record that you want to open. 

Note: A description with the prefix [Pending] means that the record has pending changes that are not yet 
approved. You can open the record, but you cannot make further changes until the review and approval 
process ends.

2. To verify that you have the correct record, expand the entry to display a few details about the record. 

3. Click the record. 

The Dashboard view of the record opens.

4. In the View list, select Business Entity. 

5. View the record details in the details pane. 
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Using Queries to Find Records
Use a search query, when you want to repeatedly perform the same search and filter operation. When you use 
search queries, you specify a criteria for your search. You might want to use queries to find records that you 
want to view, edit, or delete.

To create and manage queries, use the Queries page. You can create a query to search for records based on 
a specific business entity. To reuse the query that you create, save the query. If you use a query frequently, 
you can set it as the default query.

When you create a query with a lookup field that is dependent on other lookup fields, these other lookup 
fields are automatically included in the query. For example, the City lookup field is dependent on the State 
and Country lookup fields. When you create a query to include only the City lookup field, the State and 
Country lookup fields are automatically included in the query.

Types of Queries
You can use a basic or an extended query.

If a basic query does not return the results you are looking for, use an extended query. An extended query can 
find records that are missed by the basic query.

Basic Queries
Basic queries use simple text comparisons to find records that contain the query values. You can use text 
and the wildcard character (*) to query values.

The wildcard characters are special search symbols that you can use in basic queries to specify a text 
pattern instead of specific characters. You can use the asterisk (*) wildcard character to increase your 
chances of finding the records that you want. The wildcard characters are useful when you do not know the 
exact text or want to search for similar text.

The following table lists example search strings and explains how they function: 

Example Query 
String

Query Behavior

John Smith Queries for records that contain John, Smith, or any variations of John or Smith as a field 
value.

"John Smith" Queries for records that contain John Smith or any variations of John Smith as a field value.

John* Queries for records that contain a value that starts with John. For example, Johnson or 
Johnny.

Jo*n Queries for records that start with Jo and end with n. For example, Johansson or Jordan.

* Returns all the records.

Note: Basic query is not case sensitive in Microsoft SQL Server environments.
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Extended Queries
Extended queries use matching logic and match-enabled attributes to find records that contain the query 
values. You must enable a match rule set to use with extended queries.

Extended query results include fuzzy matches, which are more reliable. Fuzzy matches take into account 
spelling variations, and other differences to ensure that matching data that are not identical are not missed. 
For example, an extended query can match variations of the word "Street", such as "St." and "St".

Note: The extended queries use match rule sets. If an MDM administrator edits or deletes a match rule set 
from the Hub Console, the related queries are deleted from the Data Director application.

When you use extended queries, ensure that the following conditions are met:

• The business entity has match-enabled attributes.

• The match rule set used by the query is configured by the MDM administrator to use the Enable Search by 
Rules option in the Hub Console.

Creating a Query
You can create a query to search for records within a specific business entity. You are the owner of the 
queries that you create.

1. In the navigation bar, click Queries. 

2. In the Saved Queries panel, click the Add icon. 

The New Query dialog box appears.

3. From the Business Entity list, select the business entity within which you want to perform the search. 

4. Select a query type. 

Query Type Description

Basic Uses simple text comparisons to find records that contain the query values.

Extended Uses matching logic and match-enabled attributes to find records that contain the query values.

5. If you selected the extended query type, from the Match Rule Set list, select a match rule set. 

Select the Default match rule set only when a suitable match rule set does not appear in the list. A match 
rule is generated based on the values that you specify.

The fields available for the selected match rule set appear.

6. Select the fields that you want to include as the search criteria for the query. 

The fields that you selected appear in the Selected Fields section.

7. In the Selected Fields section, drag to rearrange the sequence of the fields. 

The fields appear in the query form in the sequence that you set.

8. Specify the search results options. 

a. If you want the query to be case sensitive, enable the Case sensitive option. 

b. If you want the search results sorted, from the Sort By list, select a field name by which you want 
the search results sorted. 

c. Select the sort order of the query to be ascending or descending. 

9. Click OK. 

The query is created and opens on the Queries page.
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10. To save the query for reuse, click Save. 

The Save Query dialog box appears.

11. Enter a query name and description. 

12. If you want to use the query as a default query, enable Set as my default. 

The default query is the query that appears when you open the Queries tab.

13. If you want to share the query with other users, enable Share with all. 

By default, you own the query that you create. Other users cannot edit the queries that you own.

14. Click Save. 

The query is saved and appears on the Saved Queries panel.

You can run the query that you created, or save the query and run it when needed.

Running a Query
You can run a query to find records. To run a query that is not saved, enter the search criteria, and then run 
the query. To run a saved query, first, open the query.

1. In the Saved Queries panel, open the query that you want to run. 

a. If a default query is open, but you want to run a saved query, click the Back icon to navigate to the 
Saved Queries page. 

b. Expand the business entity to which the query belongs. 

c. Click the query name. 

The query form appears.

2. Enter the search criteria for the record that you want to find. 

3. Click Run. 

The query results appear in the Search Results panel.

Viewing Query Results
After you run a query, the query results appear in the Search Results panel. You can open a record from the 
Search Results panel. Also, you can export the results to a CSV file.

To view the query results, you can perform the following tasks:
Open a record

You can open the records from the Search Results panel.

Customize the results

You can customize the results to view only the fields that are significant to your purpose.

Export the results

You can export the results to a CSV file.

Opening Records from Query Results
After you run a query to find records, you can open the records from the Search Results panel. 

1. From the Search Results panel, select a record, and click the Open in a new window icon. 

The record opens in the Business Entity view. You can view and edit the record.
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2. Select a saved query or use the default query. If a default query is open, click the Back icon to navigate 
to the Saved Queries page. 

3. If you want to open the record in any other view, from the View list, select a record view. 

Note: The record views that appear in the View list depend on the Customer 360 configuration and your 
user role privileges.

The following views are available in the Customer 360 application:

View Description

Cross-
reference 
Records

View the records that contribute to the best version of the truth of a record. You can unmerge a 
record that was merged with another record.

Matching 
Records

View the records that match the record that you opened. You can identify and resolve duplicate 
records.

Hierarchy View a diagram that shows how a record is related to other records. You can add, edit, and 
delete related records and relationships for the selected records.

History View data changes over the lifespan of the record. You can identify the data events that 
changed the data.

The record opens in the view that you select.

Customizing Query Results
You can customize the query results that appear in the Search Results panel to include only the fields that 
you want to view.

1. From the Search Results panel, click the Settings icon. 

The Customize Query Columns dialog box appears.

2. Select the fields that you want to display in the Search Results panel. 

3. Optionally, change the order in which you want the fields to appear in the search results. 

4. Click OK. 

The Customize Query Columns dialog box closes. The query results include only the fields that you 
selected.

Exporting Query Results
If you want to view the query results in a CSV file, export the query results to a CSV file.

u Export the query results to a CSV file. 

• To export all the fields, including the fields that do not appear on the Search Results panel, click 
Actions > Export All Fields.

• To export only the fields that appear on the Search Results panel, click Actions > Export Current 
Fields.

Note: Before you export the query results, you can customize the results that appear on the Search 
Results panel to include only the fields that you want to export.
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Managing Queries
After you create and save queries, you might want to modify a query, or delete a query that you do not need.

To manage queries, you can perform the following tasks:

• Edit a saved query.

• Delete a saved query.

• Save an existing query as a new query.

Note: The extended queries use match rule sets. If an MDM administrator edits or deletes a match rule set 
from the Hub Console, the related queries are deleted from the Data Director application.

Editing a Saved Query
After you create and save queries, you might want to edit the queries. You can edit queries that you create or 
own.

1. In the Saved Queries panel, open the query that you want to edit. 

a. Expand the business entity to which the query belongs. 

b. Click the query that you want to edit. 

The query opens.

2. Click Actions > Edit. 

The Edit Query dialog box appears.

3. Edit the query properties as required. 

4. Click OK. 

The query is updated. You can save or run the query.

Deleting a Saved Query
You can delete queries that you create or own.

1. In the Saved Queries panel, expand the business entity to which the query that you want to delete 
belongs. 

2. Select the query that you want to delete, and then click Actions > Delete. 

The delete confirmation dialog box appears.

3. To delete the query, click Yes. 

The query is deleted.

Saving an Existing Query as a New Query
Instead of starting from scratch, you can use an existing query to create more queries. You can either select 
or open an existing query, and then save the it as a new query.

1. In the Saved Queries panel, select the query that you want to save as a new query. 

2. Click Actions > Save As. 

The Save As dialog box appears.

3. Enter a unique name and description for the query. 
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4. Optionally, enable any of the following query options: 

• Set as my default. The query becomes the default query.

• Share with all. The query is shared with other users.

5. Click Save. 

A copy of the query is saved with the new name, and the query opens.

6. Optionally, modify the new query. 

a. Click Actions > Edit. 

b. Edit the query as required. 

You can make the following changes to the query:

• Add fields.

• Remove fields.

• Enable the query to be case-sensitive.

• Select a field name by which the query result must be sorted.

• Set the sort order to ascending or descending.

c. Click OK. 

The query is saved with the changes.

Migrating and Sharing Saved Queries
When an MDM administrator migrates a Customer 360 configuration from one environment to another, the 
saved queries are not migrated. You need to manually export the queries from the source environment and 
then import the queries into the target environment.

Migrating and Sharing All the Saved Queries
When an MDM administrator migrates a Customer 360 configuration from one environment to another, the 
saved queries are not migrated. To migrate all the saved queries, export the queries from the source Data 
Director application and then import the queries into the target Data Director application. Also, you can share 
all the saved queries with other users, who can import the queries into their environment.

1. In the source environment, from the Saved Queries panel header, click the Export icon. 

A queries JSON file, which contains all the saved queries, is downloaded to the default download 
location. You can send the queries JSON file to other Customer 360 users who can import the file into 
their environment.

2. Import the JSON file into the target application. 

a. Copy the downloaded JSON file to an accessible location in the target application environment. 

b. From the Saved Queries panel header, click the Import icon. 

c. Locate and import the queries JSON file. 

All the saved queries are migrated to the target environment.
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Migrating and Sharing a Single Saved Query
You can migrate a single saved query from one Customer 360 environment to another.

1. From the source environment, export the query that you want to migrate. 

a. In the Saved Queries panel, expand the business entity to which the the query to export belongs. 

b. Select the query and click Actions > Export. 

A query JSON file, which contains the saved query, is downloaded to the default download location. You 
can send the query JSON file to other Customer 360 users who can import the file into their 
environment.

2. Import the JSON file into the target application. 

a. Copy the JSON file to an accessible location in the target application environment. 

b. In the target application, from the Saved Queries panel header, click the Import icon. 

c. Locate and import the JSON file. 

The saved query is migrated to the target environment.
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C h a p t e r  5

Editing Records
This chapter includes the following topics:

• Editing Records Overview, 42

• Scenario for Editing a Record, 42

• Editing a Record, 43

• Deleting a Record, 43

• Adding a Tag, 44

Editing Records Overview
You might want to add or make changes to the information in a record. To make changes to a record, search 
for the record, and open the record in the Business Entity view.

If your user role permits it, you can edit the data or delete the record. When you save changes, based on your 
user role, a review process might be initiated. In this case, Customer 360 saves the requested changes in a 
pending record until the review process ends. If the review ends in an approval, Customer 360 applies the 
change from the pending record to the active records.

Scenario for Editing a Record
A customer named John Smith reports that he did not receive the product that you mailed to him. You want 
to check his address, correct errors, and redirect the product to the correct address.

You find the record for John Smith, which you select and open to view the address. You find that the address 
has an incorrect postal code. After you correct the address, you close and save the record. You ensure that 
you resend the product to the correct address.
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Editing a Record
If your user role includes the edit permission, you can edit a record in the active state.

Note: You cannot edit a record that is in the pending state because the record has changes that are pending 
approval. You must wait until the review and approval process ends.

1. From the Search Results panel of the Search page, click the record that you want to edit. 

The Dashboard view of the record opens.

2. From the View list, select Business Entity. 

The record opens.

3. Click Edit. 

Tip: If the button is disabled, either you do not have permission to edit the record or the record has 
changes that are pending approval.

4. Edit the data in the parent record as required. 

a. Click anywhere in the top section. 

The section becomes editable.

b. Edit the data. 

c. Click the Apply icon. 

5. Edit the data in child records as required. 

a. Expand the child section. 

b. Click the Edit icon. 

The section becomes editable.

c. Edit the data. 

d. Click the Apply icon. 

6. Click the Save button. 

If your user role permits you to save data without a review, the application saves the record to the MDM 
Hub Store as active records. Otherwise, the application saves the record as pending record and initiates 
the review process associated with your role.

Deleting a Record
If your user role includes the delete permission, you can delete records in the active state. You cannot delete 
a record that is in the pending state because the record is part of a workflow and is pending approval.

1. From the Search Results panel of the Search page, select the record that you want to delete. 

2. Open the record. 

3. Click Actions > Delete. 

A confirmation box appears.

4. Click Yes. 

Customer 360 marks the record as deleted and no longer displays the record, but does not remove the 
record from the database.
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Adding a Tag
Tags are a way to associate a label or information to your customers. You can add tags to a customer in the 
dashboard view.

1. Search for a customer. 

2. Select the customer to which you want to add the tags. 

3. In the Tags panel, click Add a Tag. 

4. Enter the tag that you want to add to the customer, and click Add. 

5. Repeat step 4 until you add all the tags to the customer. 

6. Click Done. 

All the tags are added to the customer.
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C h a p t e r  6

Working with Drafts
This chapter includes the following topics:

• Working with Drafts Overview, 45

• My Records Page, 45

• Timeline, 46

• Editing a Draft, 47

• Submitting a Draft, 47

• Deleting a Draft, 47

Working with Drafts Overview
When you create or edit record data, you can save the in-progress data entry form as a draft. You can partially 
fill in the record details and save for later. At any time, you can edit and complete the data entry, and then 
submit the data for approval.

My Records Page
Use the My Records page to organize your work and get an insight into your drafts and records submitted for 
approval. You can work on the drafts and submit them for approval.

To go My Records, click My Records in the left navigation pane.
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The following image shows the My Records page: 

Timeline
The details panel of tasks and drafts contains record details and the timeline for the record. The timeline 
shows in chronological order, the comments, history of changes, and actions taken on the record.

The following image shows the timeline for a record: 
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Editing a Draft
Before you submit a draft for approval, you can make changes to the draft record.

1. In the navigation pane, click My Records. 

2. Click Drafts and select the draft that you want to edit. 

3. click Edit. 

The entity view opens.

4. Edit the data as required and save the changes. 

The draft of the record is updated.

Submitting a Draft
You can submit a draft for approval.

1. In the navigation pane, click My Records. 

2. Click Drafts, and then select the draft that you want to submit. 

3. Click Submit. 

Deleting a Draft
If you never want to submit your changes for approval, delete the draft to avoid confusion.

1. In the left navigation pane, click My Records. 

2. Click Drafts. 

3. Select the record that you want to discard, and then click Discard. 

4. In the confirmation box, click Discard. 
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C h a p t e r  7

Participating in Review Processes
This chapter includes the following topics:

• Participating in Review Processes Overview, 48

• Task Manager, 49

• Task Types, 52

• Claiming Tasks, 53

• Resolving Tasks, 54

• Organizing Work on Tasks, 58

Participating in Review Processes Overview
When a business user adds or changes data in Customer 360, the change triggers a review process. A review 
process is an automated business process that notifies business managers when changes are ready for their 
review.

The type of review process depends on the configuration whether the default review processes are in use. 
There might be different review processes for creation, edits, merges, and unmerges.

Example of a Review Process for Edits
The staff in the Despatch department use Customer 360 to keep customer address information up to date.

In the Despatch department, each user credential includes one of the following user roles:

• Sales Operation Analyst. The user have permission to add and change records, but the changes must go 
through a review process before the master data is updated.

• Sales Operation Manager. A Sales Operation Manager is a type of manager with additional permissions. A 
Sales Operation Manager reviews changes and has the authority to approve them.

A Sales Operation Analyst edits the customer data as requested by the customer representative. The 
following steps describe what happens during the review process.

1. A Sales Operation Analyst changes the address information of the customer and saves the change. In 
the MDM Hub Store, the state of the customer records changes from active to pending. The proposed 
edit is saved in a cross-reference record. The save action initiates the review process.

2. An instance of a review process starts and begins executing activities.
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3. When the review process reaches the first people activity, it generates a task for managers. All users 
with the role of Sales Operation Manager receive a task notification in the task inbox with the task type 
of Approve.

4. A Sales Operation Manager claims the task. The task is assigned to the manager.

5. The Sales Operation Manager opens the customer record, reviews the edit, and agrees with the edit. The 
manager resolves the task by clicking Approve.

6. The review process marks the task as complete, and follows the Approve flow. The review process 
notifies the MDM Hub that the change is approved, and then the review process ends. The MDM Hub 
changes the address information in the customer record. The customer records change to the active 
state. The creator of the record receives a notification, when a record is approved or rejected.

Task Manager
Use the Task Manager to organize, claim, and resolve tasks that are generated by review processes.

To go to the Task Manager, in the navigation bar, click Task Manager. Alternatively, you can click the title of a 
task from the task inbox in the Home page. In this case, the Task Manager displays the selected task and its 
associated record. 

The following image shows the Task Manager with a task selected: 

1. Task panel
2. Review panel

Task Panel
The task panel lists the details of the tasks. You can use the predefined filters to select the type of tasks that 
you want to view in the task panel.

When you open the Task Manager from the navigation bar, the task panel displays all the tasks. When you 
open a task from the task inbox of the Home page, the task panel displays only the details of the selected 
task. 
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The following image shows the task panel of the Task Manager:

1. Quick filters
2. Search

The following table lists the user interface elements of the task panel :

User Interface 
Element

Description

Quick filters Filters the tasks based on the predefined filter that you select.
Use one of the following filters:
- My Open Tasks. Shows your open tasks.
- My Closed Tasks. Shows the tasks that you closed.
- All Tasks. Shows all the closed, claimed, and unclaimed tasks that are assigned to your user 

group.
- All Unclaimed Tasks. Shows all the unclaimed tasks that are assigned to your user group. 
- All Closed Tasks. Shows all the tasks that the users in your user group closed.
- All Claimed Tasks . Shows all the tasks that the users in your user group claimed.

Search Searches the displayed tasks for the specified text. 

The following table lists the details that the task panel can display :

Task Detail Description

Task Title A link that displays a short description of the review task. To review the record and take action on 
the task, click the task title. The task opens in the Task Manager and displays the associated 
record in the review panel. If your role permits it, you can edit the record from this view before 
taking action on the task. 

Type Name of a people activity within the process. 
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Task Detail Description

Priority Priority of the task. The task priority can be Low, Normal, or High. When generating tasks, the 
review process assigns the same priority to all tasks of the same type. 

Task Status and 
Due Date

Status of the task and the date the task is due.
Status of the task can be Open or Closed. When the task status is Open, you can view the record 
associated with the task.
The review process calculates a default due date based on the task creation date plus a 
predefined time period.
The due date of each task is prefixed with one of the following colored dots:
- Green. Indicates that the task is not overdue.
- Red. Indicates that the task is overdue.
- Amber. Indicates that the task will be overdue in the next 24 hours.

Owner Name of the signed-in user. 

ID Instance ID of the review process that generated the task. 

Submitted Date 
and Creator

Name of the user who created the task, and the date on which the user created the task. 

Note: If you and your colleagues require different task details, contact your MDM administrator. The MDM 
administrator can update the application to display the desired details.

Review Panel
Use the review panel to review the changed record, the comments added to the task, and the workflow 
diagram. The content of the review panel differs based on the type of change that was made to the record. 

The following image shows an edited record in the review panel: 

Task Manager       51



The following image shows an edited record in the review panel: 

Element Description

Record Details Displays the details of the record associated with the task. 

Timeline Displays the history of changes, the comments, and the actions taken on the record in the 
chronological order.

Workflow 
Diagram

Displays a graphical representation of the process flow associated with the task. 
You can view the workflow diagram only if you have the ActiveVOS abAdmin role assigned. 

Task Details Displays the task details in edit mode. 

Actions Actions that you can perform on the task. The possible actions depend on the task definitions in 
the review process. Sample actions can be Approve, Reject, and Disclaim.

More Actions Additional actions that you can perform on the task. 

Edit Opens the record in edit mode. 

Open Opens the record in a separate tab. 

Task Types
By default, workflows are triggered when a user with the Sales Operation Analyst creates or updates a record. 
When a user with the Sales Operation Manager role creates or updates a record, no workflows are triggered.

The Customer 360 default configuration includes the following tasks:

Task Type Description

DraftState Created when a creator creates or updates a record and chooses to keep the 
change in draft state.

Notification Created when an approver approves or rejects a record.

Update Created when an approver sends back a record for resubmission.

FinalReview Created when a creator sends a new record or an updated record for 
approval.
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The following steps summarize what happens when a user with the Sales Operation Analyst role creates or 
updates a record and a user with the Sales Operation Manager role approves the record:

Task Task Owner Possible Actions Result

DraftState Creator Submit Record is submitted for approval. Record is 
assigned to users with Sales Operation Manager 
role.

Discard Record is deleted.

FinalReview Approver Claim User claims the tasks. Record appears in the task 
inbox of the user.

Disclaim Record is assigned back to users with the Sales 
Operation Manager role.

Approve Record is promoted. Notification sent to the creator.

Reject Record is deleted. Notification sent to the creator.

Send Back Record is sent back to the creator with comments.

Update Creator Submit for Approval Record is resubmitted for approval. Moves to the 
FinalReview workflow.

Cancel Record is deleted.

Notification Creator OK Close the workflow.

Claiming Tasks
Multiple users can share the same reviewer role. To work on a task, you must claim the task. This ensures 
that other users cannot work on the task while you work on it. Before you can claim a task, check for 
comments or attachments. 

1. Click Task Manager. 

The task panel contains a list of tasks.

2. In the task panel, select All Unclaimed Tasks. 

The task panel lists all the unclaimed tasks of your user group.

3. Select a task that you want to claim. 

The record appears in the review panel.

4. Optionally, review the comments and attachments. 

a. On the Timeline tab, read all the comments. 

b. Click Task Details. 

c. Download attachments in the File Attachments section. 

d. Click Cancel. 
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5. To claim the task, click Claim. 

The task panel is updated, and your user name appears in the Owner field of the task.

Resolving Tasks
You resolve a task by reviewing the new or changed record and then taking an action. The possible actions 
depend on the task definitions in the review process. 

Reviewing Edited Records
When you open a task to review an edited record, the fields that contain edited values are marked. 

In the MDM Hub Store, the proposed edits are contained in a cross-reference record that is set to the pending 
state. 

1. In the task inbox of the Home page, click a task that is a request to review an edited record. 

The record opens in the review panel of the Task Manager.

Note: If you open an unassigned task, be sure to claim it before you start work.

2. Look for highlighted fields and decide if the edits are valid. 

3. If you see a typographical error or an incorrect value for which you know the correct value, perform the 
following steps to edit the field: 

a. Click Edit. 

b. Make the changes as required, and then click Save. 

4. To resolve the task, click an appropriate action button, or click More Actions and select one of the 
following actions: 

Action Description

Approve If you agree with the edits and the task type permits you to approve changes, click 
Approve. The ActiveVOS® Server marks the related Final Review people activity as 
completed and performs the next activity in the process. 

Send Back If you require more information to review the edits, click Send Back. Type an explanation 
in the Comment box.

Reject If you disagree with the one or more edits, click Reject and type an explanation in the 
Comment box. The ActiveVOS Server notifies the person who edited the record. 

<Other> If you see other options in the menu, then your organization uses a custom business 
process. If the purpose of the option is not clear and your role permits access to the 
ActiveVOS console, you can open the process to understand the workflow. Otherwise, 
contact the person who created the business process.

5. Confirm your action in the confirmation dialog box. 
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6. To change the ownership of the task without resolving the task, click an appropriate action button, or 
click More Actions and select one of the following actions: 

Action Description

Reassign To ask another person to review the proposed changes, click Reassign, select the user, and type an 
explanation in the Comment box. The task is reassigned to the selected person.
Note: If this option is not available, click Task Details and select the user from the Assignee list.

Disclaim To return the task to the pool of unassigned tasks, click Disclaim and type an explanation in the 
Comment box. Someone with the same role needs to take action on the task.

The task remains open, but is no longer assigned to you.

Reviewing New Records
When you open a task to review a new record, review all field values in the record that need to be validated.

In the MDM Hub Store, the parent record and child records are in the pending state until the new record is 
approved. 

1. In the task inbox of the Home page, click a task that is a request to review a new record. 

The record opens in the review panel of the Task Manager.

Note: If you open an unassigned task, be sure to claim it before you start work.

2. Determine if the values in the record meet your business requirements. 

3. To make changes to the record data, perform the following steps: 

a. Click Edit. 

b. Make the changes as required, and then click Save. 

4. To resolve the task, click an appropriate action button, or click More Actions and select one of the 
following actions: 

Action Description

Approve If you agree with the edits and the task type permits you to approve changes, click 
Approve. The ActiveVOS® Server marks the related Final Review people activity as 
completed and performs the next activity in the process. 

Send Back If you require more information to review the edits, click Send Back. Type an explanation 
in the Comment box.

Reject If you disagree with the one or more edits, click Reject and type an explanation in the 
Comment box. The ActiveVOS Server notifies the person who edited the record. 

<Other> If you see other options in the menu, then your organization uses a custom business 
process. If the purpose of the option is not clear and your role permits access to the 
ActiveVOS console, you can open the process to understand the workflow. Otherwise, 
contact the person who created the business process.

5. Confirm your action in the confirmation dialog box. 
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6. To change the ownership of the task without resolving the task, click an appropriate action button, or 
click More Actions and select one of the following actions: 

Action Description

Reassign To ask another person to review the proposed changes, click Reassign, select the user, and type an 
explanation in the Comment box. The task is reassigned to the selected person.
Note: If this option is not available, click Task Details and select the user from the Assignee list.

Disclaim To return the task to the pool of unassigned tasks, click Disclaim and type an explanation in the 
Comment box. Someone with the same role needs to take action on the task.

The task remains open, but is no longer assigned to you.

Resolving Records Sent Back for Updates
If an approver sends back a record, the creator receives the task in the task inbox of the Home page. As a 
creator, you can open the task, check the comments, work on the record, and send the record for reapproval.

1. In the task inbox of the Home page, select the task. 

The record opens in the review panel of the Task Manager.

2. Click Task Details, and read the comments. 

3. Click Edit, make changes as required, and then click Save. 

4. To resolve the task, select one of the following actions: 

Action Description

Submit for Approval Submits the updated record for approval.

Cancel Deletes the record.

5. Confirm your action. 

The task is closed.

Closing Notification Tasks
When an approver approves or rejects a record, the process triggers a notification task workflow for the 
creator of the task. If you created or updated a record and sent it for approval, you get the notification in your 
task inbox.

1. In the task inbox of the Home page, click the notification task. 

2. Click OK. 

The task is closed.
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Reviewing Merge Proposals
When you open a task to review a merge proposal, the primary record appears beside the records that are 
selected for the merge.

1. In the task inbox of the Home page, click a task that is a request to review a merge proposal. 

The record opens in the review panel of the Task Manager.

Note: If you open an unassigned task, be sure to claim it before you start work.

2. Review the merge preview and determine if the merge is valid. The fields that appear in the merge 
preview are highlighted. 

3. To resolve the task, select one of the following actions: 

Action Description

Merge If you agree with the merge proposal and the task type permits you to approve changes, click Merge. 
The ActiveVOS Server marks the related Merge people activity as completed and performs the next 
activity in the process.

Cancel If you disagree with the merge proposal, click Cancel and type an explanation in the Comment box. The 
ActiveVOS Server notifies the person who proposed the merge.

<Other> If you see other options in the menu, then your organization uses a custom business process. If the 
purpose of the option is not clear and your role permits access to the ActiveVOS console, you can 
open the process to understand the workflow. Otherwise, contact the person who created the business 
process.

The task is closed.

4. To change the ownership of the task without resolving the task, click an appropriate action button, or 
click More Actions and select one of the following actions: 

Action Description

Reassign To ask another person to review the proposed changes, click Reassign, select the user, and type an 
explanation in the Comment box. The task is reassigned to the selected person.
Note: If this option is not available, click Task Details and select the user from the Assignee list.

Disclaim To return the task to the pool of unassigned tasks, click Disclaim and type an explanation in the 
Comment box. Someone with the same role needs to take action on the task.

The task remains open, but is no longer assigned to you.

Reviewing Unmerge Proposals
When you open a task to review an unmerge proposal, a preview shows the result of the unmerge.

1. In the task inbox of the Home page, click a task that is a request to review an unmerge proposal. 

The unmerge preview for the record appears in the review panel of the Task Manager.

Note: If you open an unassigned task, be sure to claim it before you start work.

2. Review the unmerge preview and determine if the unmerge is warranted. The fields that appear in the 
preview are highlighted. 
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3. To resolve the task, click an appropriate action button, or click More Actions and select one of the 
following actions: 

Action Description

Unmerge If you agree with the unmerge proposal and the task type permits you to approve changes, click 
Unmerge. The ActiveVOS Server marks the related Unmerge people activity as completed and 
performs the next activity in the process.

Cancel If you disagree with the unmerge proposal, click Cancel and type an explanation in the Comment box. 
The ActiveVOS Server notifies the person who proposed the unmerge.

<Other> If you see other options in the menu, then your organization uses a custom business process. If the 
purpose of the option is not clear and your role permits access to the ActiveVOS console, you can 
open the process to understand the workflow. Otherwise, contact the person who created the 
business process.

The task is closed.

4. To change the ownership of the task without resolving the task, click an appropriate action button, or 
click More Actions and select one of the following actions: 

Action Description

Reassign To ask another person to review the proposed changes, click Reassign, select the user, and type an 
explanation in the Comment box. The task is reassigned to the selected person.
Note: If this option is not available, click Task Details and select the user from the Assignee list.

Disclaim To return the task to the pool of unassigned tasks, click Disclaim and type an explanation in the 
Comment box. Someone with the same role needs to take action on the task.

The task remains open, but is no longer assigned to you.

Organizing Work on Tasks
When you have a long list of tasks, you can organize tasks by sorting and filtering the list, changing task 
properties, and assigning tasks to others. 

For example, you might want to work on the tasks that have the highest priority or on the tasks that are due 
soonest. After you filter the list of tasks, you might find tasks that need a higher priority or tasks that you can 
work on at a later date. You can edit the task properties to better reflect the urgency within the business to 
resolve tasks.

Editing Due Date, Priority, and Other Task Properties
As you work with tasks, you might decide that some task properties need to be changed. For example, if 
changes are made to the record of an important client, you might want to increase the priority of the review 
task. Or, if you plan to be away and want to finish a set of tasks before you leave, you can change the due 
dates for the tasks to represent a date before your planned absence.

1. In the navigation bar, click Task Manager. 

2. In the task panel, select the task you want to edit. 
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3. In the review panel, click Task Details. 

4. Edit one or more of the following fields to change the task properties: 

Field Description

Task Title Enter a title that is more meaningful to you. A good title includes at least the name of the 
record and the change that initiated the review.

Priority Select a priority that reflects the urgency within the business to resolve this change.

Due Date Select a due date that reflects the urgency within the business to resolve the change.

Assignee Reassign this task to someone else.

File Attachment Attach files to provide additional information about the task. Attachments appear in the 
Task Details dialog box.
Note: The File Attachment field is available only if the task supports attachments.

Add Comment Add comments to explain edits to the task properties and to track questions and answers 
about the task. Comments appear in the Comments tab.

Assign Back to 
Pool

Return the task to the pool of unassigned tasks so that other users can claim the task.
Note: The Assign Back to Pool button is available only if the task belongs to another user.

5. Click Save. 

Assigning Tasks
If the business process management supports reassignment, you can assign tasks to other users. To find out 
if task assignments can be done, open the Task Details dialog box and see if the Assignee list is enabled.

1. In the navigation bar, click Task Manager. 

The task panel contains a list of your assigned tasks and all unassigned tasks.

2. In the task panel, select My Open Tasks. 

The task panel displays all your open tasks.

3. Select the task that you want to assign to another user. 

The record appears in the review panel.

4. To provide additional information about the task, click Task Details, and then add a comment or a file 
attachment. 

Note: If you do not have the options for comments or attachments, contact your MDM administrator to 
request that they enable comments and attachments.

5. To assign the task, select the user from the Assignee list. 

6. Click Save. 
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Assigning Tasks Back to the Pool
When a user in your user group is not available, you can send the user's tasks to the pool of unassigned tasks 
so that other users can claim them. The option to assign the tasks back to the pool is available only if the 
task belongs to another user.

1. Click Task Manager. 

2. In the task panel, select the task that you want to send to the pool. 

3. In the review panel, click Task Details. 

4. Click Assign Back to Pool. 

Disclaiming Tasks
If you claim or are assigned a task that you feel would be better handled by someone else, you can disclaim 
the task. Disclaimed tasks return to the pool of unassigned tasks. 

1. Click Task Manager. 

2. In the task panel, select an assigned task. 

The record appears in the review panel

3. In the review panel, click More Actions > Disclaim. 
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C h a p t e r  8

Importing Data
This chapter includes the following topics:

• Importing Data Overview, 61

• Import Summary Report, 61

• Import Template, 62

• Import File, 62

• Match Rule Sets, 63

• Match Results, 63

• Importing Data, 65

Importing Data Overview
You can import data in bulk from a CSV source file into the Customer 360 database. To import data, populate 
the data in one of the predefined templates. A predefined template contains a list of fields associated with a 
business entity view. The import process helps you to create or update multiple primary records in a single 
operation. You can import up to 10000 records at a time.

Before you import, you can perform an ad hoc match to compare the import data with the existing records. 
The match process identifies duplicate and unmatched records. You can then select to import the unmatched 
records or all the records.

You can stop the import at any point while it is in progress. However, you cannot roll back the imported 
records. After the import operation is complete, it generates an import summary that shows the number of 
imported and rejected records. If your user role permits, Customer 360 saves the imported records as active 
records. Otherwise, Customer 360 saves the imported records as pending records and initiates the review 
process associated with your role.

Import Summary Report
When you import data into Customer 360 database, the import operation generates a summary report.

The report lists the following information:

• Number of records created
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• Number of records updated

• Number of records processed with exceptions

• Number of records not imported because the import was stopped before completion

The following image shows a sample import summary report: 

In addition, the report shows the selected template, the name of the import file, and the match rule set used 
in the ad hoc match.

The import operation writes the rejected records to a CSV file. You can download the rejected records, 
analyze, identify the issues with the records, and update the records. You can reimport the corrected records.

Import Template
An import template contains the list of columns associated with a business entity view. The columns map to 
the columns in the base object tables in the Operational Reference Store. The columns in the import file must 
map to the columns in the template. The import file can have a subset of the columns in the template.

If the file you want to import does not match an existing template, ask the Administrator to add the required 
template.

Import File
You import data from an import file. You must use a CSV file, which is a flat file with the data separated by a 
delimiter, such as a comma. Ensure that the columns in the import file match the columns in the import 
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template. Ensure that the required columns are present in the file. The import file can have a subset of the 
columns in the template.

Match Rule Sets
A match rule set contains a logical set of match rules. Match rules define the criteria for the match process 
to determine whether two records are duplicates. Based on the requirements and the purpose of the match, 
the MDM Hub administrators configure match rule sets in the MDM Hub Console. The ad hoc match process 
uses a match rule set to identify the duplicate records.

Match Results
When you perform the ad hoc match, Customer 360 generates the match results that contain the details of 
the matched and unmatched records. You can review the match results to determine whether to import all 
the records or the unmatched records.

The match results show the following information:

• Number of input records

• Number of matched records

• Number of unmatched records
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The following image shows sample match results and a list of matched records:

1. Input records

2. Matched records

3. Filter

4. Table settings

5. Match rule description

The Unmatched Records tab lists the unmatched input records. The Matched Records tab lists the input 
records and their matched records as matched pairs. The Source_<Column Name> columns refer to the 
columns in the input file, and Target_<Field Name> columns refer to the business entity fields. The 
Ruleset_RuleNo column displays the rule set name and the rule number that matches an import record with 
an existing record. On hovering over a Ruleset_RuleNo column value, you can see the match purpose and the 
match columns that the rule uses. You can filter the records and use the table settings to select the columns 
you want in the match result tables.

You can download the match reports as a .zip file. The .zip file contains the CSV files that list the matched 
and unmatched records.
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Importing Data
You can import data in bulk into Customer 360.

1. In the navigation pane, click File Import. 

The Choose a Template page opens.

2. To choose the data you want to import, select the import template and the format of the file you want to 
import. 

3. Optionally, to download the template, perform the followings steps: 

a. Click View Template Details. 

The Choose a Template page lists the columns available in the template and their data types.

b. Click Download Template. 

Based on your browser settings, the Save As dialogue box might appear where you can choose the 
directory to save the template. The template is downloaded as a CSV file. Use the template to 
create the input file.

4. Click Next. 

The Specify Import Properties page opens.

5. Browse to the file that contains the data that you want to import, and then click Open. 

6. In the Import Properties panel, specify the following import file properties: 

Property Description

Delimiter Character that represents the break between data values in the import file. Select a 
predefined delimiter or select Other to define a custom delimiter.

Character Encoding Character encoding used in the file. Character encoding is the mapping of the 
characters from a language or group of languages to hexadecimal code. Select UTF-8 
or UTF-16 encoding.

Text Qualifier Symbols used in the file to enclose a string.

Header Enter the number of the row that serves as the header row in the file.

Date format Date format for the date fields in the import file.

Source System Required. Source system that supplied the records to import.

Primary Key Column Column in the import file to consider as the primary key column. The primary key 
column must exist in the import file. If the value in the column does not exist in the 
base object, the import operation inserts a record. If the value in the column exists in 
the base object, the import operation updates the record. The column can have null 
values.
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7. To control what data to import from the file, set one of the following properties: 

Records Property

All records Select All Records.

Range of records Specify the From Row and the Number of Records to Import.

8. Click Validate and Preview. 

Note: To continue, you must validate and preview the import file.

9. Click Next. 

The Import File page opens.

10. To match the input records with the existing records, perform the following steps: 

a. In the Ad Hoc Match section, select Yes. 

b. Select one of the match rule sets available in the list. 

Note: An MDM administrator configures the match rule sets in the MDM Hub Console.

c. Click Match Records. 

After the match process is complete, the match results are displayed.

d. If you want to filter the match results, click Filter, and then click Add Field. 

The following table lists the different user interface elements that you can find in the Match Results 
section:

User Interface Elements Description

Displays the Add Field list.

Add Field Displays a list of fields that you can use to define filters. Based on the data 
type of the field, select the condition or a range to filter the results.
For example, to filter data based on a date range, select the date field and set 
the date range.

Clears all the applied filters. After you clear the filters, the icon changes to 

.

e. To configure the columns that you want to view in the Match Results section, click Table Settings, 
select and order the columns, and click OK. 

f. To download match reports, click Download Reports. 

The match report is downloaded as a .zip file. The .zip file contains CSV files that list the matched 
and unmatched records.

g. In the Import section, select the type of records you want to import. 

11. Click Import Records. 

After the import process is complete, the import result displays the number of imported records and the 
number of rejected records.
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12. To stop the import while it is in progress, click Stop Import. 

The import result displays the number of imported records, rejected records, and unprocessed records.

13. To download the list of rejected records as a CSV file, click Download. 
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C h a p t e r  9

Resolving Duplicates
This chapter includes the following topics:

• Resolving Duplicates Overview, 68

• Scenario for Duplicate Records, 69

• Resolving Duplicate Records, 70

• Resolving Duplicate Child Records within a Record, 72

Resolving Duplicates Overview
The match process identifies matching records based on match rules. When you open the Matching Records 
view for a record, Customer 360 retrieves data about the matching records from the matches table. You can 
also search for other similar records and add them to the view.

In the Matching Records view, you can review the records in the similar records. You start with the parent 
records. If you identify duplicate records based on the data in the parent records, select the records. The 
merge preview for the parent record shows you the results of the proposed merge. Next, you can compare all 
the child and descendant records of the selected records. If some of the records contain different values for 
the same field, the merge preview process refers to the trust score for the data. The most trustworthy data is 
used in the merged record. At any time, you can open a preview of the merged record.

When you are sure that the merge preview reflects the best version of the truth, start the merge process. If 
your user role requires that someone else review the proposed merge record, Customer 360 saves the record 
and starts a merge review workflow. When an authorized person approves the proposed merge, the MDM 
Hub updates the master data to reflect the merged record.

Match Process
The match process uses match rules to identify the records that are similar to the record that you opened in 
the Business Entity view. The degree of similarity among the records depends on how the match rules are 
defined.

The MDM Hub Administrator or a Data Steward defines the match rules in the Hub Console. Match rules 
identify the record columns to search and the type of match to use, that is, fuzzy or exact. For more 
information about match rules, see the Multidomain MDM Configuration Guide.

This list of similar records is only a starting point. Records can be similar, without being duplicate records. 
You must review the similar records and identify the duplicates.
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Merge Process
To resolve duplicate records, you merge a target record with the duplicate records. The merge process 
creates a record that contains the most trustworthy data from all the participating records.

At the parent level, the merge process merges the data of the parent record.

At the child level, when the parent-to-child relationship is a one-to-one relationship, the merge process 
merges the child records. When the relationship is a one-to-many relationship, you can select the child 
records to merge from the Matching Records view. All records that are not selected for a merge are added to 
the merged record.

Note: Developers define the parent-to-child relationships when they define the structure of the business 
entity.

After the merge process handles a child record, it tries to merge each level of descendant records using the 
same merge strategies. The merge process must run successfully on a level before the process can try to 
merge the next level.

The following image shows how the merge process works on three records, where each record has a parent 
record and two child-level relationships:

The merged record contains the merged parent record, the merged child records, and all the records that 
were not merged.

Scenario for Duplicate Records
You work for an insurance organization. A customer, Paula Laine, calls to review her home insurance policy. 
You ask Ms. Laine for her policy number, and enter the policy number in the Search bar.

In the search results, you select the record that contains the policy number, and open the record in the 
Business Entity view. You confirm a few personal details and then answer Ms. Laine's questions about her 
policy.
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After you answer her questions, you ask Ms. Laine if she has any other policies. Ms. Laine tells you that she 
has an automobile policy registered with a subsidiary of your organization. You enter the automobile policy 
number in the Search bar, and the search returns the record that contains the automobile policy. You verify 
that the personal data matches the data in the other record.

After you end the conversation, you open the record that contains the home policy in the Matching Records 
view. From the similar records, you select the record that contains the automobile policy. You click Preview 
and verify that both policies appear in the Policies section. In addition, you can see that the merged record is 
more complete overall, with data such as Ms. Laine's middle name and her mobile phone number coming 
from different source records. When you are satisfied that the merge preview represents the best version of 
the truth, you start the merge process.

Resolving Duplicate Records
Use the Matching Records view to compare similar records. When you identify records that are duplicates, 
you can resolve the duplicates by merging the records.

To identify and resolve duplicate records, perform the following tasks:

1. “Identifying Duplicate Records” on page 70

Review the suggested similar records and, optionally, find other records that you think might be 
matches. Select duplicates.

2. “Identifying Duplicate Child Records” on page 71

After you select duplicate records, the Navigate menu updates to include the child records and 
descendant records from the duplicate records. Review the child records. Select duplicates.

3. “Merging Duplicate Records” on page 72

Start the merge process.

Identifying Duplicate Records
Compare the data in a target record with similar records in the Matching Records view. Start with the parent 
record, then use the Navigate menu to open the child records and their descendant records.

Initially, the Navigate menu reflects the structure of the target record. After you select duplicate records, the 
merge preview shows the result of merging the parent records of the target and duplicate records. The merge 
preview process applies the merge cascade rules to the child records and descendant records. The structure 
in the Navigate menu changes to reflect the structure of the proposed merged record.

1. With a record open, select Matching Records. 

The Matching Records view opens with the target record in the second column. The first column 
contains the Merge preview. The remaining columns contain the records that satisfy a match rule that is 
associated with the records of the target record. The row labels in the grid correspond to the column 
names in the parent record.

2. Optionally, show only the records that satisfied a specific match rule. 

a. Click the Filter tab. 

b. Select Specify a match rule. 

c. Click in the field and select the match rule from the list. 

Tip: If the list is empty, the records of the target record have no match rules.
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3. If you think that the match process missed a similar record, you can add it. 

a. Click Add. 

The Find and select entities page opens.

b. Type the text or value that you want to find, and click Search. 

The search returns all records that contain the search term.

c. Optionally, select filters to restrict the search results and click Apply Filter. 

d. Expand the details for a record by clicking the plus icon beside the name. 

e. Select the records that you want to add. 

f. Click Select. 

The records appear in the Matching Records view. If a record is already displayed in the view, it is 
not added again.

4. Compare the data in the parent records across all the similar records. 

5. Optionally, to change the fields displayed for each record, click the View button. 
For example, you can show or hide the system columns.

6. When you determine that a record is a duplicate of the target record, select the check box in the column 
header for that record. You can select more than one record. 

The Merge preview shows the result of merging the parent records.

7. Click Preview. 

The Business Enitity Preview opens. The preview shows the result of merging the records that belong to 
the target and duplicate records.

8. To close the preview, click Back. 

You return to the Matching Records view.

Identifying Duplicate Child Records
After you preview the merge of duplicate records, review the child records and their descendant records in 
the Matching Records view. Select a record from the target record. You can select one or more duplicate 
records to merge with the target record.

Note: As you work with the child records, you might find data that makes you decide that a record is not a 
duplicate after all. You can return to the Overview screen and clear the check box for that record. The merge 
preview process regenerates the Merge Preview. The merge preview process keeps any manual merges that 
you created among the records in the remaining records. If a manual merge contained records from the 
removed record, those records are removed from the manual merge.

1. In the Navigate tab, expand a node and select a child record from the target record. 

The grid changes. The second column contains the selected child record, which is the target record. The 
remaining columns display the sibling records.

Tip: If a pending icon appears in the column header for the target record, the record is in the pending 
state and cannot participate in a merge process. Select a different record as the target record.

For example, you might see multiple telephone numbers for the target record plus all the telephone 
numbers that belong to the duplicate records.

2. If you see a sibling record that is a duplicate of the target record, select the check box in the column 
header. You can select more than one record. 

Tip: If a pending icon is shown instead of the check box, the record is in the pending state and cannot be 
selected for a merge.
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The Merge Preview column shows the result of merging the target record with the duplicate records.

3. Repeat the process on the remaining child records. Optionally, you can perform the same process on 
descendant records. 

4. Click Merge. 

5. In the Merge Duplicates dialog box, confirm the merge. 

A manual merge request is saved in an internal change list.

Merging Duplicate Records
After you select duplicate child records and descendant records for manual merges in the Matching Records 
view, start the merge process.

1. In the Navigate tab, click Overview. 

You can see the parent records in the view.

2. Optionally, preview the proposed merged record. 

a. Click Preview. 

b. Review the proposed merged record. The Preview is similar to the Business Entity view. 

c. Click Back. 

3. Click Merge. 

Based on your user role, one of the following actions occurs:

• If your user role permits you to merge records without a review, the merge process merges the 
records in the selected records. The merged records are in the active state.

• If your user role requires a review process, the merge process starts the merge review workflow. The 
records that will participate in the merge remain in the active state, but the merge occurs only after 
the merge proposal is approved.

Related Topics:
• “Merge Process” on page 69

• “Identifying Duplicate Records” on page 70

Resolving Duplicate Child Records within a Record
To look for duplicate child records within a single record, open the record in the Matching Records view. Do 
not select any other records.

1. With the record open, select Matching Records from the View list. 

In the grid, the second column contains the selected record. In this scenario, ignore any similar records.

2. In the Navigate tab, expand a node and select a child record from the record. 

The grid changes. The second column contains the selected child record, which is the target child 
record. The remaining columns contain the sibling child records, if any.

3. If you see a sibling record that is a duplicate of the target child record, select the check box in the 
column header. You can select more than one child record. 
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The Merge Preview column shows the result of merging the target child record with the duplicate child 
records. The merge request is saved in an internal change list.

4. Repeat the process on the remaining child records. Optionally, you can perform the same process on 
descendant records. 

5. In the Navigate tab, click Overview to return to the parent record. 

6. Click Merge, and then confirm the merge. 

The merge process implements the manual merge requests on the sibling child records. Based on your 
user role, one of the following actions occurs:

• If your user role permits you to merge records without a review, the merge process merges the child 
records. The merged child records are in the active state.

• If your user role requires a review process, the merge process initiates the merge review workflow. 
The child records that participate in the merge remain in the active state, but the merge occurs only 
after the merge proposal is approved.
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C h a p t e r  1 0

Investigating Data Changes
This chapter includes the following topics:

• Overview, 74

• Scenario for Data Changes in History View, 74

• Comparing Data Changes in the History View, 75

Overview
You can compare the best version of the truth at different moments in time for a particular record. If you 
suspect that the data in the record has changed inappropriately, you can use the History view to identify the 
data event that caused the data change.

The History view displays a chronology of data changes over the lifespan of the record. You can view the 
data that existed in the record at any point in time in the chronology. View the data before a data event and 
after a data event to determine if the event caused the inappropriate data change. A data event is any action 
that changes the data in a record, such as an edit or a merge operation.

Scenario for Data Changes in History View
A customer reports that he recently changed his email address and he wants to confirm that you have his 
current contact details. You look in the History view for the record that represents this customer.

The customer stated that he changed his address in October of the current year, so you look for data events 
in the History view chronology that occurred around that time. You see that multiple data events occurred in 
October for the record. You navigate to the Email child record and compare the data before and after the data 
events. You see that the new email address for the customer was added. After further investigation, you see 
that the middle name of the customer was added.
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Comparing Data Changes in the History View
Use the History view to compare changes to master data.

1. With the record open, select History. 

The History view opens. Changes to the record appear on the timeline.

2. Optionally, select filters to show or hide different types of events. 

3. Optionally, select a time unit to group data events. To do this, click Options and choose a different 
timescale. For example, select M to select a monthly timescale. 

The following image shows data events grouped under the month of October:

4. Click the event labeled Email. 

The event details panel shows the record details before and after the event and the time when the record 
was updated. In this example, the email address has changed from jsmith@example.com to 
jxsmith88@example.com.

5. Click the event labeled SMITH, JOHN. 

The following image shows that the display name of the record changed from John Smith to John Xavier 

Smith.
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C h a p t e r  1 1

Investigating Hierarchies and 
Relationships

This chapter includes the following topics:

• Investigating Hierarchies and Relationships Overview, 76

• Scenario for Adding Related Records, 76

• Opening a Record in the Hierarchy View, 79

• Displaying Relationships on the Canvas, 79

• Investigating Related Records, 84

• Changing Records and Relationships, 87

Investigating Hierarchies and Relationships Overview
A record can have relationships with other records. You can view a graph that shows how a record is related 
to other records. Use the Hierarchy view to investigate relationships and the related records.

Relationships describe the affiliation between two records. The MDM Hub supports one-to-many and many-
to-many relationships between records, in addition to hierarchical relationships between records in the same 
record. You can view, add, edit, and manage relationships between a record and other related records. In the 
Related Records panel, you can view the records that directly relate to the record that is open in the Entity 
view.

Scenario for Adding Related Records
A relationship is configured between the Organization and the Person business entities, such that an 
organization employs persons. You have an organization, Informatica, to which you want to add the 
employees. John Smith is an employee of Informatica.

You search for Informatica. You open the record. You search for the Person business entity that represents 
John Smith. You add John Smith as a related record to Informatica. After an appraisal, John Smith has a 
different job title and salary. You must update the relationship details to reflect the change. You open 
Informatica and select the relationship between Informatica and John Smith. You update the relationship 
details.
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Relationships for a Person
Default relationships are configured for the Person customer. You can add the relationships from the 
relationship panels of the business entity view. If you do not see the relationship type that you want to add, 
request the administrator to configure the relationship.

By default, the Person customer has the following two relationship panels configured:

• Relationship. The relationships that you can add from the panel include relationships such as guardian, 
spouse, child, or sibling.

• Household. The relationship that you can add from the panel is member of a household.

Relationships for an Organization
Default relationships are configured for the Organization customer type. You can add the relationships from 
the relationship panels of the business entity view. If you do not see the relationship type that you want to 
add, request the administrator to configure the relationship.

By default, the Organization customer type has the following three relationship panels configured:

• Relationship. The relationships that you can add from the panel include the linkage relationships between 
different companies within a corporate family.

• Contact. The relationship that you can add from the panel includes the relationship of a person entity to 
the organization, such as employee or contact.

• Classification. The relationships that you can add from the panel include classification type for the 
organization.

Adding a Related Record
When a record has relationships configured, you can add related records to the record. Search for and open 
the record in a Business Entity view. Search for the record that you want to add as a related record and add 
the record in the Related Records panel.

Note: The Related Records panel must be present in the Business Entity view.

1. From the Search Results panel of the Search workspace, select the record to which you want to add the 
related records. 

2. Open the record. 

The Related Records panel displays the records that are directly related to the record you open. There 
might be more than one Related Records panel.

3. In the Related Records panel, click New. 

The Add a Related Record page opens.

4. Select the relationship type. 

5. In the Search box, type the complete search string or the search string with the asterisk wildcard 
character (*) for the record that you want to find. 

6. Click Search. 

7. In the Filters panel, select a value for the filter criteria that you require. 

8. Click Apply Filter. 

The revised search results appear in the Search Results panel based on the filters you set.

9. Select the record that you want to add as related record and click Proceed. 
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10. If the relationship has additional attributes, specify the additional attributes. 

For example, for a PersonOwnsAutomobile relationship, you might have to specify the mileage and price.

11. Click Save. 

The record is added as related record and appear in the Related Records panel.

Viewing Related Records
To view the records related to a record, search for and open the record. You can view the related records in 
the Related Records panel. Each related record in the component is a link that you can open in an Entity View.

1. From the Search Results panel of the Search workspace, select the record. 

2. Click Entity View. 

The related records are listed in the Related Records panel.

Editing Related Records
You can edit the details of the relationship between a record and the related record. You can edit the 
additional attributes associated with the relationship. Search for the record and edit the relationship from the 
Related Records panel.

1. From the Search Results panel of the Search workspace, select the record that you want to edit. 

2. Open the record. 

The Related Records panel displays the records that are directly related to the record you open. There 
might be more than one Related Records panel.

3. In the Related Records panel, select the related record that you want to edit, and then click the Edit icon. 

4. Edit the additional relationship attributes, and then click Save. 

For example, assume that job title and salary are two attributes associated with the 
OrganizationEmploysPerson relationship. After an appraisal, you might edit the job title and salary for 
that Person record to reflect the changes.

Deleting a Related Record
You can delete the relationship between a record and a related record. Search for the record and then delete 
the related record in the Related Records panel.

1. From the Search Results panel of the Search workspace, select the record that you want to edit. 

2. Open the record. 

The Related Records panel displays the records that are directly related to the record you open. There 
might be more than one Related Records panel.

3. Select the related record that you want to delete, and then click the Delete icon. 

A confirmation box appears.

4. To delete the relationship, click Delete. 

Customer 360 deletes the relationship between the record and the related record and no longer displays 
the related record in the Related Records panel.
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Opening a Record in the Hierarchy View
Use the Hierarchy view to examine the relationships between the open record and other records.

1. To open a record in the Hierarchy view, select a record. 

The record opens.

2. From the View list, select Hierarchy. 

The Hierarchy view opens. The selected record and the related records appear on the canvas.

Displaying Relationships on the Canvas
You can change the way that records and relationships appear on the Hierarchy canvas. You can change the 
layout, create and apply filters, hide or show related records, or change other canvas display options.

Selecting a Layout
Different layouts can reveal different insights into record relationships. You can customize the size and 
spacing in some of the layouts.

1. In the canvas, click the Layouts tab. 

The Layout panel opens.

2. Click a layout icon. 

Layout Layout Name

Hierarchy.

Tree.

Circular.

Taxonomy.
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Layout Layout Name

Network.

Explorer View.

3. Click Apply. 

The canvas displays the relationships between the records in the selected layout. If you can customize 
the layout, one or more options appear in the Layouts panel.

4. To customize the layout, set the layout options. 

• To increase a value, move the slider to the right, and then click Apply.

• To decrease a value, move the slider to the left, and then click Apply.

• In the Network layout, you can choose whether to show spheres of influence. When selected, the 
Sphere of influence option encloses each record in a circle. The size of the circle reflects the number 
of direct relationships held by each records. The more direct relationships, the larger the circle.

Filtering Related Records
Use filters to show or hide a set of records and relationships. For example, you might want to simplify the 
view so that you can focus on a particular relationship.

Defining a Filter
Use the Filters panel below the canvas to select filter options to apply to the canvas.

To enable a filter option, select the option check box. To disable a filter option, clear the check box. Filter 
options are cumulative. You can select as many or as few as you need to clarify the relationships on the 
canvas. In logical terms, filters are joined by the AND operator.

1. In the Hierarchy view, click the Filters tab that is located below the canvas. 

The Filters panel opens.

2. In the Hierarchies section, select the check boxes for one or more types of business entities. 

The filter affects all selected types of business entities.

3. Click the name of a business entity. 

The relationship filter options for the selected business entity appear to the right.

4. Optionally, change the relationship filter options for the record. 

5. Optionally, click General and change the general filter options: 

Option Description

Hide unconnected entities Hides records with no relationship to the selected record.
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Option Description

Show pending relationships Shows relationships that are currently under review.

6. Optionally, click Relationship Directions and change the directional filter options: 

Option Description

Show Parents Shows the parents of the selected record.

Show Children Shows the child records of the selected record.

Show Unknown Shows records where the relationship between the records is unknown.

Show Undirected Shows related records where the type of relationship is not specified.

Show Bidirectional Shows related records where the direction of the relationship goes both ways.

7. Click Apply. 

The application applies the selected filter options to the canvas.

Saving a Filter
If you expect to reuse the filter options that you applied to the canvas, save the options as a filter. After you 
save a filter, you can choose to make the filter the default filter whenever the selected record is displayed in 
the canvas.

1. In the Filters panel, click Saved Filters. 

2. Type a name in the Filter Name field. 

3. To share the filter with colleagues, select Public. 

4. Click Save. 

The filter options that are currently applied to the view are saved.

5. To always apply this filter with the selected record, click the Default for <Business Entity> button. 

Applying a Saved Filter
When you apply a saved filter, the filter applies to the types of business entities selected in the filter.

1. In the Filters panel, click Saved Filters. 

2. Select the filter from the Filter Name list. 

The filter options reflect the settings in the selected filter.

3. Click Apply. 

The canvas reflects the settings in the applied filter.

Applying a Default Hierarchy Filter
When you apply a default hierarchy filter, the filter applies to the selected business entity.

1. In the Filters panel, click Defaults. 
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2. Select the filter from the Default hierarchy list. 

The filter options reflect the settings in the selected filter.

3. Click Apply. 

The canvas reflects the settings in the applied filter.

Deleting a Saved Filter
You can delete saved filters that you no longer use. If the filter is public, check with colleagues before you 
delete it.

1. In the Filters panel, click Saved Filters. 

2. Select the filter from the Filter Name list. 

The filter options reflect the settings in the selected filter.

3. Click Delete. 

Hiding and Showing Records on the Canvas
You can hide or show selected records and relationships on the canvas. When you hide a record on the 
canvas, the relationship of the record to the primary record remains intact, but the relationship is not shown 
on the canvas.

After you hide a record, the Hierarchy view updates the remaining records that are related to the hidden 
record. In the canvas, the related records show the number of visible relationships out of the total number of 
relationships, and display a plus sign icon to show that some relationships are hidden. In the relationship 
table, the row that represents the hidden record does not have a canvas icon.

Showing Direct and Indirect Relationships
In the Hierarchy view, direct and indirect relationships between records are expressed in hops. A hop is a 
relationship between records. A direct relationship is one hop, while an indirect relationship is more than one 
hop. For example, given records A, B, C, and D, the relationship A--D is one hop, A--B--D is two hops, and A--B--
C--D is three hops. You can change the number of hops that appears for a selected record.

1. In the canvas, click a record. 

The Actions button appears.

2. Perform one of the following actions: 

• To view direct relationships, click the Actions button and click Fetch > One Hop.

• To view direct and indirect relationships, click the Actions button and click Fetch > Many Hops (#).

3. Optionally, change the number of hops that are shown by the Many Hops (#) option. 

a. Click the Actions button and click Fetch > Preferences. 

b. In the Show Many Hops dialog box, set a value between 2 and 20. 

c. Click Execute. 

d. Click the Actions button. 

The Many Hops (#) menu item reflects the value that you set.

e. To apply the new number of hops to the canvas, click Fetch > Many Hops (#). 
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Hiding a Record
If the graph is complex, you can simplify the graph by hiding records that are not meaningful to your 
investigation. When you hide a record, the record and the relationships of the record are hidden. You cannot 
hide the primary record or a record that functions as the anchor of the graph in the canvas.

1. On the canvas, click the record. 

The Actions button appears.

2. Click Actions. 

3. Click Hide > Hide Entity. 

On the canvas, the record and the relationships of the record are hidden.

Hiding Selected Records
Select one or more records to hide. You cannot hide the primary record or a a record that functions as the 
anchor of the graph in the canvas.

1. In the canvas, select records by pressing the Ctrl key and clicking the records. 

Selected records are highlighted.

2. On the toolbar, click the Actions icon, and then click Hide Selected Entities. 

In the canvas, the selected records and the record relationships are hidden.

Hiding a Record's Children
You can hide the children of a selected record. To qualify as a child record, the Direction type of the child 
record must be Child.

1. In the canvas, click the record. 

The record Actions button appears.

2. Click Actions. 

3. Click Hide > Hide Children. 

In the canvas, the children of the selected record are hidden.

Showing a Hidden Record
You can show a hidden record and the relationships of the record in the canvas.

1. In the canvas, click a record. 

2. If the relationship table is closed, click the arrow button to open the relationship table. 

The relationship table displays all records that are directly related to the selected record.

3. In the relationship table, select the hidden record that you want to show in the canvas. 

4. Right-click and click Add to Canvas. 

In the canvas, the record and the relationships of the record are displayed.
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Showing All Hidden Relationships
When a record box includes a plus sign icon in the lower left corner, the record has relationships to hidden 
records. You can show all the hidden records.

u To show all hidden records, click the Show icon in the record box. 

The hidden records and the relationships of the record are shown on the canvas.

Navigating the Canvas
In the canvas, you can zoom in or out on the graph, move around the graph, or move quickly to another part of 
the graph.

• To zoom in or out on the graph, move the slider up or down.

• To view hidden adjacent parts of the graph, use the direction arrows to move the hidden records into view.

• To navigate quickly through a large hierarchy graph, click the Navigation tab and click a different area of 
the graph. The area appears in the canvas.

Setting Canvas Display Options
You can set options that control the canvas.

• To increase the height of the canvas, click the Full Screen Mode icon. The application header and 
workspace bar are hidden.

• To show the canvas legend, click the Other tab. The legend appears on the left.

• To use simple graphics in the canvas when the number of records exceeds a threshold, click the Other 
tab, set a threshold value, and click Apply.

Investigating Related Records
As you investigate the relationships for the selected record, you might need to review the details for a related 
record or for a relationship.

You can view the following kinds of details:

• Record data

• Source systems and pending records

• System columns

• Relationship details

• Hierarchy

• History of changes
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Viewing Record Data
If you need more information about a record, you can view the record data. For example, when the hierarchy 
contains similar records, you might want to confirm that you have the correct record before taking an action.

1. In the canvas, click a record. 

The record Actions button appears.

2. Click Actions. 

3. Click View > Details. 

4. In the Entity Details window, review the summary details. 

• If the details are sufficient to allow you to continue your work, click Close.

• If you need more information about the record, click More Details. The record opens in a new tab. 
You can review all the data about the record and, if necessary, edit the data.

Viewing Source Systems and Pending Changes
You can view information about contributing source systems and pending changes for a selected record.

In the MDM Hub Store, the information is stored as cross-reference (XREF) records.

1. In the canvas, click a record. 

The record Actions button appears.

2. Click Actions. 

3. Click View > Cross References. 

4. In the Cross References dialog box, review records. 

• If the details are sufficient to allow you to continue your work, click Cancel.

• If you need to make changes, edit values, and then click Save.

Viewing System Columns
Data stewards might be interested in viewing the values in the system columns for a selected record. For 
example, you can view values for the Rowid Object column and Creator column.

1. In the canvas, click a record. 

The record Actions button appears.

2. Click Actions. 

3. Click View > System Columns. 

4. In the System Columns window, review the values. 

5. When you are finished, click Close. 

Viewing and Editing Relationship Details
If you need more information about a relationship, you can view details about the relationship, such as the 
relationship type.

1. In the canvas, click a relationship line. 

The relationship Actions button appears.
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2. Click Actions. 

3. Click View Relationship Details. 

4. In the Edit Relationship dialog box, review the details about the relationship. 

Option Description

Diagram Displays a diagram of the related records and the direction of the relationship.

Hierarchy The type of the business entity, such as organization or household.

Relationship Type The type of relationships that are possible between the records, such as employee or 
relative.

Rel Start Date The start date of the relationship. If the date occurs in the past, the relationship is active. If 
the date occurs in the future, the relationship will start on the specified date. If the field is 
empty, a start date was not set.

Rel End Date The end date of the relationship. If the date occurs in the past, the relationship has ended 
and is inactive. If the date occurs in the future, the relationship will end on the specified 
date. If the field is empty, the relationship is currently considered permanent.

Switch Entities You can switch the order of the record to change the direction of the relationship. The 
Switch Entities button is enabled for some Relationship Types.

Other fields Additional fields might appear for some Relationship Types.

5. Optionally, to change the relationship details, edit options and click Save. 

Adding a Relationship
You can create a relationship between two unrelated records as long as a relationship type exists for the 
business entities.

1. Ensure that both records are visible on the canvas. You might need to use the slider to zoom out the 
canvas. 

2. Drag and drop one record box on top of the other record box. 

3. In the Add Relationship dialog box, configure the following options: 

Option Description

Diagram Displays a diagram of the related records and the direction of the relationship.

Hierarchy The type of the business entity, such as organization or household.

Relationship Type The type of relationships that are possible between the records, such as employee or 
relative.

Rel Start Date The start date of the relationship. If the date occurs in the past, the relationship is active. If 
the date occurs in the future, the relationship will start on the specified date. If the field is 
empty, a start date was not set.
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Option Description

Rel End Date The end date of the relationship. If the date occurs in the past, the relationship has ended 
and is inactive. If the date occurs in the future, the relationship will end on the specified 
date. If the field is empty, the relationship is currently considered permanent.

Switch Entities You can switch the order of the records to change the direction of the relationship. The 
Switch Entities button is enabled for some Relationship Types.

Other fields Additional fields might appear for some Relationship Types.

4. Click Save. 

In the canvas, a relationship line appears between the two records. If the relationship is directional, the 
line includes an arrowhead to show the direction.

Changing Records and Relationships
In the Hierarchy view, you can add, edit, and delete related records and relationships for the selected record. 
If an effective date is set, the update is valid for the selected effective date.

Adding a Record to the Canvas
To create a relationship to a record that is not on the canvas, search for the record and add it to the canvas.

1. On the toolbar, click Add to Canvas. 

If you navigate to the Hierarchy view from a record tab, the Smart Search dialog box opens. If you 
navigate to the Hierarchy view from the legacy Data tab, the Search dialog box opens.

2. If the Smart Search dialog box opens, perform the following steps: 

a. Optionally, select the type of business entity. 

b. Type the search term. 

c. Click Search. 

If the search process finds matches, the matching records appear in the search results.

d. Optionally, use the filters to narrow the search results. 

e. If the record appears in the search results, select the record and click Select. 

The record appears on the canvas.

3. If the legacy Search dialog box opens, perform the following steps: 

a. Enter the search criteria. 

b. Click Run Search. 

c. If the record appears in the search results, select the record and click Add to Canvas. 

The record appears on the canvas.

4. Next steps. Create a relationship between the added record and other records. 
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Adding a Relationship
You can create a relationship between two unrelated records as long as a relationship type exists for the 
business entities.

1. Ensure that both records are visible on the canvas. You might need to use the slider to zoom out the 
canvas. 

2. Drag and drop one record box on top of the other record box. 

3. In the Add Relationship dialog box, configure the following options: 

Option Description

Diagram Displays a diagram of the related records and the direction of the relationship.

Hierarchy The type of the business entity, such as organization or household.

Relationship Type The type of relationships that are possible between the records, such as employee or 
relative.

Rel Start Date The start date of the relationship. If the date occurs in the past, the relationship is active. If 
the date occurs in the future, the relationship will start on the specified date. If the field is 
empty, a start date was not set.

Rel End Date The end date of the relationship. If the date occurs in the past, the relationship has ended 
and is inactive. If the date occurs in the future, the relationship will end on the specified 
date. If the field is empty, the relationship is currently considered permanent.

Switch Entities You can switch the order of the records to change the direction of the relationship. The 
Switch Entities button is enabled for some Relationship Types.

Other fields Additional fields might appear for some Relationship Types.

4. Click Save. 

In the canvas, a relationship line appears between the two records. If the relationship is directional, the 
line includes an arrowhead to show the direction.

Editing a Record from the Hierarchy View
As you work with related records in the Hierarchy view, you might find that you need to edit data.

1. In the canvas, click a record. 

The record Actions button appears.

2. Click Actions. 

3. Click Edit > Edit Entity. 

A tab opens and displays the record in the Data view.

4. Edit data as required and save the changes. 

5. To return to the Hierarchy view, click the tab that contains the Hierarchy view. 

Deleting a Record from the Hierarchy View
As you work with related records in the Hierarchy view, you might find that you want to delete a record. When 
you delete a record, the record is removed from the view, and the records are marked for deletion in the MDM 
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Hub Store. All the relationships between the deleted record and the selected record are also deleted. You 
cannot delete the record whose hierarchy you are viewing.

1. In the canvas, click the record that you want to delete. 

The record Actions button appears.

2. Click Actions. 

3. Click Edit > Detete Entity. 

The record and the relationships of the record are removed from the canvas and the relationship table. 
The record is marked for deletion in the MDM Hub Store.

Deleting a Relationship
You can delete relationships between records. You can delete the relationship immediately, or you can cause 
the relationship to expire with an end date.

The End Date Relationship option is available under the following circumstances:

• The end date is empty.

• The relationship belongs to the current source system specified for the application.

• One cross-reference record persists in the database for the current effective period where the record does 
not intersect with effective periods from other source systems.

You delete relationships from the canvas.

1. In the canvas, click the relationship line. 

The relationship Actions button appears.

2. Click Actions. 

3. Choose how you want to delete the relationship. 

• To delete the relationship and mark it with an end date, click End Date Relationship. When prompted 
for confirmation, click Yes. The end date is set to the date before the selected effective date.

• To delete the relationship from the selected effective period without adding an end date, click Delete 
Relationship.

• To delete the relationship for all effective dates, click Delete All Relationship Periods.

The relationship line disappears and the relationship is deleted from both affected records.
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C h a p t e r  1 2

Viewing the Relationship Graph
This chapter includes the following topics:

• Relationship Graph Overview, 90

• Opening the Relationship Graph View, 91

• Relationship Graph User Interface, 91

• Filtering the Records, 92

• Aggregating the Records, 93

• Setting the Visualization Options, 94

• Modifying the Graph View, 95

Relationship Graph Overview
A relationship graph connects a group of business entities through relationships. You can use Informatica 
MDM - Relate 360 to create a relationship graph. After you create a relationship graph in Relate 360, you can 
view the relationship graph in Customer 360.

The following image shows a representational relationship graph:

In the representational relationship graph, Customer, Product, Transaction, and Service Request are business 
entities, and owns, transaction, and complaint are relationships that connect the business entities. The 
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representational graph can display all the products a customer owns. The graph can also display the service 
requests and the transaction details of each product the customer owns.

Note: The Customer 360 environment must be integrated with Relate 360 to view the relationship graph.

Opening the Relationship Graph View
You can access the relationship graph through the custom view that is created for the relationship graph.

1. Open a record. 

2. Select the custom view that is created for the relationship graph. 

The relationship graph appears.

Relationship Graph User Interface
The relationship graph displays a graph, filters, and column values for the selected record. The graph 
displays all the related records of the selected record. You can filter the records in the graph based on the 
filters that are available for the business entity.

The following image shows a sample relationship graph:

1. Graph panel

2. Fields panel

3. Filters panel

4. Visualization Options panel

A relationship graph includes the following panels:
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Graph panel

Displays how the selected record is connected to other records. The graph changes based on the filters 
that you apply.

Fields panel

Displays the columns related to a record that you select in the graph. The columns that appear in the 
Fields panel depend on the parameters that you configure in the relationship configuration file.

Filters panel

Displays the filters that you can use to filter the records. You can filter the records based on the 
business entities and their column values. You can also aggregate the records based on the columns of 
the business entity.

Visualization Options panel

Allows you to highlight the relationships and records. You can also hide or show the labels of the 
relationships and nodes.

Filtering the Records
You can filter the records based on their column values. You can also filter all the records that are related to 
a business entity.

1. Open the relationship graph. 

By default, the graph displays the selected record and all its related records.

2. To remove all the records that belong to a business entity from the graph, under Filter, clear the business 
entity. 

The graph refreshes and removes all the records that belong to the business entity from the graph.

3. To include all the records that belong to a business entity in the graph, under Filter, select the business 
entity. 

4. To filter the records based on the column values of a business entity, perform the following tasks: 

a. Under Filter, click the filter icon  of a business entity whose columns you want to use to 
filter the records. 

A list of columns appear. The columns that are available in the list are based on the parameters that 
you configure in the relationship configuration file.

b. Select a column. 

If you have configured the column as an exact filter, a text box appears. If you have configured the 
column as an enumeration filter, a list of enumeration values appear.

c. For an exact filter, type the exact column value based on which you want to filter the records. 

d. For an enumeration filter, select the enumeration value based on which you want to filter the 
records. 

The following image shows the enumeration values configured for the PaymentMode column:
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e. Click OK. 

The graph refreshes to reflect the filtered records.

Aggregating the Records
You can aggregate the records based on the selected columns of a business entity.

1.

Under Filter, click the aggregate icon  of a business entity whose columns you want to use to 
aggregate the records. 
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2. Select the columns based on which you want to aggregate the records, and click OK. 

The graph refreshes to reflect the aggregated records.

The following image shows Gene Jackson's related records that are aggregated based on the 
ProductName column:

Setting the Visualization Options
You can select to show or hide the labels of the relationships and nodes in the relationship graph. You can 
also turn the highlight effect on or off for the relationships and nodes.

In the Visualizations Options panel, click the following icons that you can find against each relationship and 
business entity:

Icon Description

Turns the highlight effect on or off.

Shows or hides the labels of the relationships or nodes.
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Modifying the Graph View
You can zoom in, zoom out, and perform other actions in the graph to modify the view of the graph.

In the Graph panel, click the following icons that you can find in the upper right corner of the panel:

Icon Description

Adjusts the graph to highlight how the selected node is related to the main node.

Aligns the graph to the center of the panel.

Zooms in or zooms out the graph so that the entire graph fits the panel.

Resets the graph to its original size.

Zooms out to reduce the size of the nodes.

Zooms in to increase the size of the nodes.

Resets the graph to its default layout.

Modifying the Graph View       95



I n d e x

A
adding 

address 28
campaign 29
classification value 29
household 28
time period 28
time period group 29

adding records 
overview 23

assigning 
tasks 59

assigning back to pool 
tasks 60

B
business entities 

about 11
scenario for adding 24

business entity records 
editing 42
searching 42
searching and editing example 42

C
canvas, Hierarchy See Hierarchy canvas 
charts and graphs 

about 14
child records 

merging 71, 72
claiming 

tasks 53
compare 

about 11
concepts 

master data management 11
Customer 360 application 

about 10
Customer 360 application developer 

about 10

D
DaaS 

address verification 27
email address verification 27
phone number verification 27

data changes 
before and after, comparing 75
History view, viewing 75

data changes (continued)
overview 74

data entry forms 
Business Entities view, using 25, 26

data quality 
about 12, 26

data validation 
Business Entity view 24

deleting 
records 43

drafts 
about 45
deleting 47
editing 47

duplicates 
identifying 70
resolving 68

E
editing 

business entity records 42
overview 30, 42
records 30, 43

entities 
business 11

F
filtering 

records 33
filters 

Hierarchy view 80
tasks 18

H
hierarchies 

investigating 76
Hierarchy canvas 

records, hiding selected 83
direct and indirect relationships, showing 82
displaying records and relationships 79
hops, showing 82
layout, selecting 79
navigating 84
options, setting 84
record children, hiding 83
record, adding 87
record, showing a hidden 83
records, hiding 82, 83
records, showing 82
records, showing all hidden 84

96



Hierarchy view 
filter, saving 81
filters 80
filters, applying default 81
filters, applying saved 81
filters, defining 80
filters, deleting saved 82
opening 79
pending changes, viewing 85
record data, viewing 85
record system columns, viewing 85
records, deleting 89
records, editing 88
relationship details, viewing 85
relationship, creating 86, 88
relationships, deleting 89
source systems, viewing 85

History view 
data changes, investigating 74

home page 
about 17

hops 
showing, in the Hierarchy canvas 82

I
importing data 

import file 63
import summary report 61
import template 62
operation 65
overview 61

Informatica MDM-Customer 360 
about 10

interface 
language, change 12

K
key concepts 

about 11

L
language 

changing 12
localized 

user interface 12
logging in 12

M
match process 

about 68
Matching Records 

overview 68
merge 

about 12
task, reviewing 57

merge process 
entity 360 framework 69

merging 
child records 71, 72
duplicate records 72

O
objects 

base 11

P
password 

changing 12
processes 

match 68
merge 69
review, about 12

Q
queries 

basic 36
creating 36
default 36
extended 36
migrating,exporting,importing 40, 41
saving 36
sharing 36

Queries 
page 

tab 31
query 

basic 35
extended 36
types 35
using wildcards 35

R
record relationships 

example 76
records 

adding 26
adding, to Hierarchy canvas 87
deleting 43
edited, reviewing 54
editing 30, 43
filtering 33
identifying duplicates 70
matching 68
merging duplicate 72
new, reviewing 55
opening 34
resolving duplicate 72
scenario for duplicate 69
searching 30
viewing 34

Records 
adding 25
searching 32

related records 
adding 77
deleting 78
editing 78
viewing 78

relationships 
adding, in Hierarchy view 86, 88
between business entities 12
deleting, in Hierarchy view 89

Index        97



relationships (continued)
investigating 76
organization 77
person 77

review panel 
about 51

review processes 
about 12
edit review process, example 48
participate 48

S
scenario 

adding records 24
search 

for business entity records 42
for records 30, 32

search and compare 
about 11

Search page 30
searching 

overview 30, 42
searching and editing 

example 42
signing in 12
submissions 

about 45
system columns 

Hierarchy view, viewing 85

T
tabs 

Search 30
task inbox 

columns 19
task panel 

about 49
tasks 

about 12
assigning 59
assigning back to pool 60

tasks (continued)
claiming 53
disclaiming 60
edited records, reviewing 54
editing properties 58
filtering 18
merge proposals, reviewing 57
new records, reviewing 55
organizing work 58
ownership 53, 60
ownership, setting 59
resolving 54
sorting 18
unmerge proposals, reviewing 57

tasks panel 
about 15

U
UI 

language, changing 12
unmerge 

task, reviewing 57
user interface 

about 13

V
validating 

address 27
email address 27
phone number 27

validation 
data, Business Entity view 24

viewing customer data 
customer dashboard 19

W
workflows 

review processes 12

98        Index


	Table of Contents
	Preface 
	Informatica Resources
	Informatica Network
	Informatica Knowledge Base
	Informatica Documentation
	Informatica Product Availability Matrices
	Informatica Velocity
	Informatica Marketplace
	Informatica Global Customer Support


	Chapter 1: Introduction to Informatica MDM - Customer 360
	Overview of Informatica MDM - Customer 360
	Key Concepts
	Business Entities
	Search and Compare
	Merge
	Review Processes and Tasks
	Hierarchies and Relationships
	DaaS Validation

	Logging In
	User Interface
	Charts and Graphs
	Task Inbox
	My Records Page


	Chapter 2: Getting Started
	Getting Started Overview
	Home Page
	Sorting and Filtering Tasks
	Configuring the Columns for the Task Inbox
	Viewing Customer Data
	Customer Dashboard


	Chapter 3: Adding Records
	Adding Records Overview
	Data Validation

	Adding a Person Scenario
	Adding an Organization Scenario
	Adding a Person Record
	Adding an Organization Record
	DaaS Validation Overview
	Address Verification and Standardization
	Email Address Validation
	Phone Validation

	Validating a Postal Address, an Email Address, or a Phone Number
	Adding a Household
	Adding an Address
	Adding a Time Period
	Adding a Time Period Group
	Adding a Classification Value
	Adding a Campaign

	Chapter 4: Finding Records
	Finding Records Overview
	Search Page
	Queries Page

	Using the Search Box to Find Records
	Filtering Records
	Viewing and Opening a Record

	Using Queries to Find Records
	Types of Queries
	Creating a Query
	Running a Query
	Viewing Query Results
	Managing Queries
	Migrating and Sharing Saved Queries


	Chapter 5: Editing Records
	Editing Records Overview
	Scenario for Editing a Record
	Editing a Record
	Deleting a Record
	Adding a Tag

	Chapter 6: Working with Drafts
	Working with Drafts Overview
	My Records Page
	Timeline
	Editing a Draft
	Submitting a Draft
	Deleting a Draft

	Chapter 7: Participating in Review Processes
	Participating in Review Processes Overview
	Example of a Review Process for Edits

	Task Manager
	Task Panel
	Review Panel

	Task Types
	Claiming Tasks
	Resolving Tasks
	Reviewing Edited Records
	Reviewing New Records
	Resolving Records Sent Back for Updates
	Closing Notification Tasks
	Reviewing Merge Proposals
	Reviewing Unmerge Proposals

	Organizing Work on Tasks
	Editing Due Date, Priority, and Other Task Properties
	Assigning Tasks
	Assigning Tasks Back to the Pool
	Disclaiming Tasks


	Chapter 8: Importing Data
	Importing Data Overview
	Import Summary Report
	Import Template
	Import File
	Match Rule Sets
	Match Results
	Importing Data

	Chapter 9: Resolving Duplicates
	Resolving Duplicates Overview
	Match Process
	Merge Process

	Scenario for Duplicate Records
	Resolving Duplicate Records
	Identifying Duplicate Records
	Identifying Duplicate Child Records
	Merging Duplicate Records

	Resolving Duplicate Child Records within a Record

	Chapter 10: Investigating Data Changes
	Overview
	Scenario for Data Changes in History View
	Comparing Data Changes in the History View

	Chapter 11: Investigating Hierarchies and Relationships
	Investigating Hierarchies and Relationships Overview
	Scenario for Adding Related Records
	Relationships for a Person
	Relationships for an Organization
	Adding a Related Record
	Viewing Related Records
	Editing Related Records
	Deleting a Related Record

	Opening a Record in the Hierarchy View
	Displaying Relationships on the Canvas
	Selecting a Layout
	Filtering Related Records
	Hiding and Showing Records on the Canvas
	Navigating the Canvas
	Setting Canvas Display Options

	Investigating Related Records
	Viewing Record Data
	Viewing Source Systems and Pending Changes
	Viewing System Columns
	Viewing and Editing Relationship Details
	Adding a Relationship

	Changing Records and Relationships
	Adding a Record to the Canvas
	Adding a Relationship
	Editing a Record from the Hierarchy View
	Deleting a Record from the Hierarchy View
	Deleting a Relationship


	Chapter 12: Viewing the Relationship Graph
	Relationship Graph Overview
	Opening the Relationship Graph View
	Relationship Graph User Interface
	Filtering the Records
	Aggregating the Records
	Setting the Visualization Options
	Modifying the Graph View

	Index

